PREFACE

This manual explains how to use the Control Techniques PLC Operator Station products and CTIU software.

Copyright © 1999 Control Techniques PLC, The Gro Pool Road Newtown Powys UK SY16 3AJ. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer language, in any form by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the prior agreement and written permission of Control Techniques PLC.

Information in this document is subject to change without notice and does not represent a commitment on the part of Control Techniques PLC.

Windows 95®, Windows 98®, and Windows NT® are registered trademarks of Microsoft Corporation. DeviceNet is a trademark of Open DeviceNet Vendors Association (ODVA). Profibus is a trademark of Siemens. Cscape, CsCAN, and SmartStack are trademarks of Horner APG, LLC.

For user manual updates, your nearest Control Techniques Drive Centre.

Limited Warranty and limitation of liability

Control Techniques PLC. ("CT-PLC") warrants to the original purchaser that the Operator Station distributed by CT-PLC is free from defects in material and workmanship under normal use and service. The obligation of CT-PLC under this warranty shall be limited to the repair or exchange of any part or parts which may prove defective under normal use and service within eighteen (18) months from the date of manufacture or one (1) year from the date of installation by the original purchaser whichever occurs first, such defect to be disclosed to the satisfaction of CT-PLC after examination by CT-PLC of the allegedly defective part or parts. THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES AND CT-PLC NEITHER ASSUMES, NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR CT-PLC, ANY OTHER LIABILITY IN CONNECTION WITH THE SALE OF THE Operator Station. THIS WARRANTY SHALL NOT APPLY TO THE Operator Station OR ANY PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE, OR MISUSE. HE MAKES NO WARRANTY WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE. THE TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN THAT PERSON FOR WHOM THE Operator Station IS ORIGINALLY INSTALLED.

In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise, shall CT-PLC or its suppliers be liable of any special, consequential, incidental or penal damages including, but not limited to, loss of profit or revenues, loss of use of the products or any associated equipment, damage to associated equipment, cost of capital, cost of substitute products, facilities, services or replacement power, down time costs, or claims of original purchaser's customers for such damages.

To obtain warranty service, return the product to your drive centre with a description of the problem, proof of purchase, post paid, insured and in a suitable package.
About programming examples

Any example programs and program segments in this manual or provided on accompanying diskettes are included solely for illustrative purposes. Due to the many variables and requirements associated with any particular installation, Control Techniques PLC, LLC cannot assume responsibility or liability for actual use based on the examples and diagrams. It is the sole responsibility of the system designer utilising the Operator Station to appropriately design the end system, to appropriately integrate the Operator Station and to make safety provisions for the end equipment as is usual and customary in industrial applications as defined in any codes or standards which apply.

NOTE: The programming examples shown in this manual are illustrative only. Proper machine operation is the sole responsibility of the system integrator.

Declaration of EMC conformity

Distributor's Name: Control Techniques PLC.
Distributor's Address: The Gro, Pool Road, Newtown, Powys, UK SY16 3AJ

Declares that the products Models: CTIU050, CTIU100, CTIU110 and CTIU200

Conforms to the following EMC standards:

EMC: EN 55 022, Radiated and Conducted Emissions
     EN 50 082-1, RF, EFT/EFB, ESD Immunity

Supplementary Information:

The above conformity only relates to the products in a stand-alone capacity. The products are used as part of a system and are therefore classified as a component. As a component, the products are prohibited by EC regulations to carry a CE Mark for EMC conformity. Static discharge tests only apply to normal operation of the keyboards via the front panel. We would stress that the use of our products within your system, while helping to ensure compliance of your system to the same directives, do not necessarily guarantee that compliance will be achieved. We would also like to point out that the interpretation of the law concerning CE marking and its application to sub-assemblies and components is open to interpretation.

Date: 31 Mar 1999
Revisions to this manual

This version (SSP-2050-1002) of the CTIU software Version 4.10 for the Operator Station contains the following revisions, additions or deletions:

a. Added chapter detailing firmware upgrade. Section 1.5
b. Revised chapter on recipes.
c. Section on trending revised as per customer request.
d. Expanded the SmartStack chapter.
e. Added section on analogue meters.
f. Added section to text selector to include font size, and font editor.
g. Added section in download project to mention protocol check prior to download.
h. Changed TIU range specification table (Operating Temperature).
i. Added section explaining folder layout, and protocol file name.
j. Added new overlays for CTIU10X and CTIU11X.
k. Moved Key Mapping 7.7 and Function Keys 7.8 to the About Projects 8.17 and 8.18.
l. Revised operating temperature specifications in Table 1.2 (maximum temperature range).
   Also revised part numbers listed under weight and dimensions.
m. Trending now available for the CTIU10X.
n. Add description internal, network and system registers.
o. Added sections on Control Techniques devices
**TABLE OF CONTENTS**

**PREFACE**
- Limited Warranty and limitation of liability 3
- About programming examples 3
- Declaration of EMC conformity 4
- Revisions to this manual 5

**TABLE OF CONTENTS** 6

1. **INTRODUCTION** 7
   - General 7
   - Equipment Needed 8
   - Technical Specifications 9
   - Software Installation Instructions 10
   - Upgrade Revision Software & Firmware 10
     - General 10
     - Software Upgrade 10
     - Firmware Upgrade 10

2. **CTIU050** 11
   - General 11
     - CTIU050 Button Selection Actions 11
     - CTIU050 Contrast Adjustment 11
   - CTIU050 Ports 12
     - CTIU050 Configuration of the RS-485 Port 12
     - CTIU050 Dimensions 13

3. **CTIU100/101** 15
   - General 15
     - CTIU100 Button Selection Actions 15
     - CTIU100 Contrast Adjustment 15
   - CTIU100 Rear View 16
     - CTIU100 Ports 16
     - CTIU100 Configuration of the RS-485 Port 17
   - CTIU100 Dimensions 18

4. **CTIU110/111** 19
   - General 19
     - CTIU110 Button Selection Actions 19
     - Contrast Adjustment 19
   - CTIU110 Rear View 20
     - CTIU110 Ports 20
     - CTIU110 Configuration of the RS-485 Port 22
   - CTIU110 Dimensions 22

5. **CTIU 200** 24
   - 5.1 General 24
     - CTIU20X Button Selection Actions 24
     - Contrast Adjustment 24
   - CTIU20X Rear View 25
     - CTIU20X Ports 25
     - CTIU20X Configuration of the RS-485 Port 27
   - CTIU20X Dimensions 27

6. **COMMUNICATIONS** 28
   - Connection of Control Techniques devices 28
     - 4 wire RS422/485 to UD71, Mentor, UD70, MD29, CDE, MC204 28
     - RS-485 Two-Wire to UD7#, commander SE and Diverter A 29
     - RS232 to UD71, UD7# 30
     - CTNet wiring guidance 30
   - Recommended Automation Equipment Communication Cables 31
6.2. Control Techniques Device Setup & Usage Details 31
   6.2.1 Control Techniques ANSI comms protocol and the CTIU: Generalities. 31
   6.2.2 CTNet (UD75) 31
   6.2.3 CTNet (MD29AN) 32
   6.2.4 Mentor drive 32
   6.2.5 MD29 32
   6.2.6 Unidrive + UD71 32
   6.2.7 Unidrive + UD7# (not UD71) 32
   6.2.8 Commander SE 32
   6.2.9 CDE 32
   6.2.10 Dinverter 32
6.3. MC204 / 216 33
6.4. Other Automation Equipment (AE) Communications Connections 34
   6.4.1 RS-232 Connection 34
   6.4.2 RS-422/485 Four-Wire 35
   6.4.3 RS485 2 wire 36
7. GETTING STARTED 37
   7.1. Self-Test 37
   7.2. Serial Loop-back Tests 37
   7.3. Selecting the Automation Equipment 38
   7.4. Details for setting up standard serial comms 40
      7.4.1 Communication Mode settings available for standard serial comms. 40
      7.4.2 Protocol selection details for Control Techniques devices. 40
      7.4.3 Choice of data rate 41
   7.5. Proving Communications 42
   7.6. Icon Descriptions 44
   7.7. Up/Down Keys 45
   7.8. Key Symbols 45
8. ABOUT PROJECTS 46
   8.1. General 46
   8.2. About TIU Terminal 46
   8.3. Creating a New Project 46
   8.4. Opening a Project 47
   8.5. Saving a Project 47
   8.6. Downloading a Project 47
      8.6.1 General 47
   8.7. Uploading a Project 47
   8.8. Verifying a Project 47
   8.9. Updating the Protocol 48
      8.9.1 Directory descriptions 48
      8.9.2 Changing Protocols 48
   8.10. Updating the Operating System 49
   8.11. Printing 49
   8.12. To Insert a New Page 49
   8.13. Download/Upload Character Set (Not available with the CTIU050) 50
      8.13.1 To Download a Character Set: 50
      8.13.2 To Upload a Character set from the TIU: 50
   8.14. Select Terminal Type 50
      8.14.1 To select the Operator Station being used: 50
   8.15. Delete a Page 51
   8.16. Font Size (Not available with the CTIU050) 51
      8.16.1 To change/set the Font Size of a line: 51
   8.17. Key Mapping 51
      8.17.1 To enable key mapping: 51
   8.18. Function Keys 52
      8.18.1 General 52
9. EMBEDDED DATA 56
   9.1. General 56
   9.2. Numeric Data 57
9.2.1 To edit numeric data: 58
9.2.2 To change data registers contents from the CTIU050/10X/11X/20X: 58
9.3. Alphanumeric Data 58
  9.3.1 General 58
  9.3.2 To embed alphanumeric data: 59
9.4. Timers 59
  9.4.1 General 59
  9.4.2 To monitor Timers on the CTIU050/10X/11X/20X: 60
  9.4.3 To edit the data field: 60
9.5. Bit Status 60
  9.5.1 General 60
  9.5.2 To select the data field for editing: 61
9.6. System Variables 62
9.7. Passwords 62
  9.7.1 To password protect a sub-menu: 62
  9.7.2 To enter the password from the CTIU050/10X/11X/20X: 63
9.8. Analog Meters 64
9.9. Text Selector 65
  9.9.1 Edit Text Tables 65
  9.9.2 To edit a text table from the CTIU050/10X/11X/20X: 67
  9.9.3 To Export/Import a Text Table 67
  9.9.4 Default Text Table Entries 67
9.10. Clock Calendar 68
  9.10.1 Clock Calendar Mapping 69
9.11. Menu Timeout 69
9.12. Flashing Characters 69
9.13. Set the Real-time Clock 70
9.14. Scaling 70
  9.14.1 To enable Scaling: 70
9.15. Page Wizard 71
  9.15.1 To use the Page Wizard: 71
9.16. Graphing (Not available with the CTIU050) 71
  9.16.1 To Embed a Graph: 72
  9.16.2 Enable Axes 72
9.17. Trending (Not available with the CTIU050) 73
  9.17.1 Enable Axes 73
  9.17.2 Data Indirectly Specified. 73
  9.17.3 Control Data from Remote Device 73
  9.17.4 To Embed a Trend 74

10. CHARACTER GENERATOR 76
  10.1. General (Not available on the CTIU050) 76
  10.2. To Insert a Special Character: 76
  10.3. To Create Or Edit a Character: 77
  10.4. International Keyboards 78

11. RECIPES 80
  11.1. General 80
  11.2. To Enable Recipes: 80
  11.3. To Edit Recipe Fields and Records: 80
  11.4. To Rename a Record 81
  11.5. To Embed a Recipe Item on a Menu Page: 81
  11.6. Importing and Exporting Data from a Recipe: 82

12. TUTORIAL 84
  12.1. General 84
  12.2. Menus 84
    12.2.1 Steps involved in building configuration. 84
  12.3. Sub-Menus 87
    12.3.1 To Enter A Sub-Menu On the CTIU050/10X/11X/20X: 89
  12.4. Password-Protected Sub-Menus 90
    12.4.1 To Enter the Sub-Menu: 91
12.4.2 To Edit The data On The Sub-Menu Pages: 91
12.5. Status 92
12.6. Alarms 97
12.6.1 General 97

13. GRAPHIC EDITOR 101
13.1. General 101
13.2. Draw Mode 101
13.2.1 Selector 101
13.2.2 Rectangle 101
13.2.3 Ellipse 102
13.2.4 Rectangle with Round Corners 102
13.2.5 Line 102
13.2.6 Arc 102
13.2.7 Text Mode 103
13.2.8 Static Bitmap 103
13.2.9 Table Mode 105
13.3. Embedding Data on a Graphic Menu Page 106
13.3.1 General 106
13.3.2 Analogue Meter 106
13.4. Animated Bit Map Selector 107
13.4.1 General 107
13.4.2 To Embed a Animated Bitmap Selector 107
13.4.3 To Edit a Bitmap table from the CTIU20X: 109
13.4.4 To Export/Import a Bitmap Table 109
13.4.5 Default Bitmap Table ID Entries 110
13.4.6 Draw Attributes 110

14. NETWORKING 111
14.1. General 111
14.2. Network I/O 111
14.3. Configuring the CTIU101/111/201 for Network Communication. 111

15. MATHEMATICS 115
15.1. General 115
Table 15.1 – Call Methods 115
15.2. Internal & System Registers 115
Table 15.2 – Register Names 115
Table 15.3 – System Registers 116
15.3. Maths Functions 116
15.4. Execution of Maths Functions 116
15.5. Mathedit Windows Application 116
15.6. Opcodes 117
15.6.1 No Operation 117
15.6.2 Conditional 117
15.6.3 Assignment 119
15.6.4 Bit Operation 120
15.6.5 Table Operation 121
15.6.6 Function 122
15.6.7 Control Flow 122
15.6.8 Set End 122
15.7. Background Functions 123
15.7.1 To Program a Background Function 123
15.8. Schedule Functions 124
15.8.1 To Set-Up a Schedule Function 124
15.9. Data Transfer Block 124
15.9.1 To Add a Block Transfer 125

16. SMARTSTACK™ 127
16.1. General 127
16.2. Installing and Removing a SmartStack Module 127
16.3. Configuring SmartStack Module 128

CTIU User Manual Issue 2 TABLE OF CONTENTS PAGE 9
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>16.4. SmartStack I/O</td>
<td>129</td>
</tr>
<tr>
<td>16.5. Module Addressing</td>
<td>129</td>
</tr>
<tr>
<td>16.6. Displaying Data From SmartStack</td>
<td>129</td>
</tr>
<tr>
<td>16.7. Considerations for Shutting Down &amp; Restarting a CTIU20X with I/O</td>
<td>130</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1. General
The Operator Station (CTIU050/10X/11X/20X) is an Operator Station (OS) that provides extensive monitoring and control in an extremely small package. The Operator Station “OS” product line offers four distinct categories of products as described in Table 1.1.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIU050:</td>
<td>Text Only</td>
<td></td>
</tr>
<tr>
<td>CTIU050-001</td>
<td>2 lines x 20 characters.</td>
<td>SSP-2050-0050</td>
</tr>
<tr>
<td>CTIU050-002</td>
<td>2 lines x 20 characters with Real Time Clock.</td>
<td>SSP-2050-0055</td>
</tr>
<tr>
<td>TIU10x:</td>
<td>Text / Semi-graphics</td>
<td></td>
</tr>
<tr>
<td>CTIU100-01</td>
<td>8 Lines x 20 Characters plus 128 x 64 pixels.</td>
<td>SSP-2050-0010</td>
</tr>
<tr>
<td>CTIU100-02</td>
<td>8 Lines x 20 Characters plus 128 x 64 pixels with RTC</td>
<td>SSP-2050-0015</td>
</tr>
<tr>
<td>TIU11x:</td>
<td>Text / Semi Graphics with Numeric Keypad</td>
<td></td>
</tr>
<tr>
<td>CTIU110-01</td>
<td>8 Lines x 20 Characters, 128 x 64 pixels &amp; numeric keypad.</td>
<td>SSP-2050-0010</td>
</tr>
<tr>
<td>CTIU110-02</td>
<td>As CTIU110-01 plus RTC</td>
<td>SSP-2050-0015</td>
</tr>
<tr>
<td>TIU20X:</td>
<td>Text / Full Graphics with Numeric / Function Keypad</td>
<td></td>
</tr>
<tr>
<td>CTIU200</td>
<td>16 Lines x 40 Characters plus 240 x 128 pixels plus a Numeric keypad / Function keypad. Optional SmartStack I/O.</td>
<td>SSP-2050-0200</td>
</tr>
</tbody>
</table>

The front panel of the OS has a bright and clear display (LCD with adjustable back lit) and easy-to-use push buttons. On the back panel are communication ports for connection to automation equipment (programmable logic controller, drive, weighing equipment or other equipment) and a PC (IBM or compatible computer). Also located on the back panel of the OS are clearly displayed features such as power input, PC and PLC port, Tx and Rx LEDs.

The OS supports a variety of protocols. Various protocols can be downloaded through the PC port and stored in the unit’s flash memory. The operating system can also be downloaded through the PC port.

The OS has a total of 300 menu and sub-menu pages (password protection available). Each page is capable of displaying up to eight embedded data items of the following types; numeric, alphanumeric, timer, bit status, Horizontal Fill, Text Selector, System Variable, Password, Clock Calendar, Data registers, Timer, Counter pre-sets and also internal bits in the automation equipment (AE) may be edited via the OS. Other features include display of status information and priority driven handling.

The CTIU100/110 is available with two non-standard features: 20mA current loop communication and a real-time clock (RTC). Both can be ordered at the time of purchase. The current loop can be re-fit by the user later. The RTC requires factor re-fit. The CTIU050 is only available with the real-time clock option.

The CTIU20X provides for the display of both text and full graphics and has a Numeric/Function Keypad.
It also allows the use of a wide range of SmartStack I/O options.

**CTIU configuration package**, Control Techniques’ Windows™-based software, is easy-to-use. The software user’s guide is contained in this manual. (See Section 1.4 for initial software
installation procedures.) All revisions of software from Version 1.34 can be obtained from your nearest Control Techniques Drive Centre.

Note: The Help File in the Software contains similar information to this manual.

1.2. Equipment Needed

1. Software Installation CD.
2. A PC Windows 95\textsuperscript{TM}, Windows 98\textsuperscript{TM} or Windows NT\textsuperscript{®}.
3. Approximately 15.7 MB of available hard disk space.
4. CTIU050/10X/11X/20X Interface Unit.
5. PC to TIU Programming Cable (PN) SSP-2050-0900 or equivalent (See Fig 2.6).
1.3. Technical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Conditions</th>
<th>Min.</th>
<th>Typical</th>
<th>Max.</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage (V_i)</td>
<td></td>
<td>10</td>
<td>24</td>
<td>32</td>
<td>VDC</td>
</tr>
<tr>
<td>Typical power consumption</td>
<td>V_i = 24VDC</td>
<td>130</td>
<td></td>
<td></td>
<td>mA</td>
</tr>
<tr>
<td>CTIU050</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU10X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU11X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU20X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inrush input current</td>
<td>V_i = 24VDC for 4ms</td>
<td>260</td>
<td></td>
<td></td>
<td>mA</td>
</tr>
<tr>
<td>Operating temperature</td>
<td></td>
<td>0</td>
<td>50</td>
<td></td>
<td>°C</td>
</tr>
<tr>
<td>CTIU050</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU10X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU11X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU20XA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU20XB or higher</td>
<td></td>
<td>0</td>
<td>45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-20</td>
<td>80</td>
<td></td>
<td></td>
<td>°C</td>
</tr>
<tr>
<td>Relative Humidity</td>
<td>(non-condensing)</td>
<td>5</td>
<td>85</td>
<td></td>
<td>%</td>
</tr>
<tr>
<td>Weight</td>
<td></td>
<td>320</td>
<td>350</td>
<td></td>
<td>g</td>
</tr>
<tr>
<td>CTIU050</td>
<td></td>
<td>370</td>
<td>400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU10X</td>
<td></td>
<td>470</td>
<td>500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTIU11X</td>
<td></td>
<td>1870</td>
<td>1900</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimensions</td>
<td>CTIU050</td>
<td>179 x 111 x 60</td>
<td></td>
<td></td>
<td>mm</td>
</tr>
<tr>
<td></td>
<td>CTIU10X</td>
<td>121 x 105 x 38</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CTIU11X</td>
<td>172 x 105 x 38</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CTIU20X</td>
<td>282 x 194 x 62</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cable Lengths</td>
<td>RS-232</td>
<td>15</td>
<td></td>
<td></td>
<td>m</td>
</tr>
<tr>
<td></td>
<td>RS-485</td>
<td>1500</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP rating</td>
<td>NEMA 4-12/IP65</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EMC Conformance</td>
<td>EN 55 022, Radiated and Conducted Emissions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-3, Radiated and Conducted RF Immunity</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ENV 50144</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

† Cables beyond the maximum recommended length may create communication problems. Both ends of an RS-485 network must be properly terminated at 120Ω and grounded.

1.4. Software Installation Instructions

2. Insert the Software Installation CD.
3. In Windows 95™, Windows 98™, or NT 4.0, click the Windows Start menu button and then click Run. The Run dialog box appears.
4. Type D:\software\disk1\setup (CD Drive letter assumed to be D:). Click OK.
1.5. Upgrade Revision Software & Firmware

1.5.1 General
To avail of any new features that are included in this new release on units that were purchased previous to this release, both software and firmware require updating by the user. Any new unit will be set-up for the latest version released.

1.5.2 Software Upgrade
To update the software requires that the user install the new version of software from the installation CD. You may install the new software over any previous version installed. See section 1.4 Software Installation Instructions.
To update existing projects simply open the project from the newly installed version of the software. Once the project is saved to disk the update is complete. For backup reasons we recommend that you save the new version of your project in a different location or under a different file name.

1.5.3 Firmware Upgrade
The following steps assume that a project or configuration is loaded to the Operator Station and that the user is running the latest version of software.

a) Upload the project/configuration from the unit.
b) If a customised character set is loaded to the unit then upload the character set also.
c) Choose Automation Device from main menu Configure/Communication Settings.
d) From File menu choose Update TIU Protocol. If you are updating from firmware version 3.00 or later then you just have to update to the latest protocol file. However if you are updating from firmware version 2.00 or earlier you must update to a dummy protocol first, then update to the latest firmware revision. See Note. (See updating protocol for further information).
e) From File menu choose Update TIU Operating System. (See Updating Operating System for more details).
f) Choose Download Character Sets to TIU from File menu.
g) Choose Download Project to TIU from File menu.

Note: When updating the protocol file the screen may go blank after the protocol file is complete. Continue with the procedure as described and the display will recover.
2. **CTIU050**

2.1. **General**

2.1.1 **CTIU050 Button Selection Actions**

1. **PAUSE** key selects data for editing or exits from data editing.
2. **PAUSE & DOWN** keys pressed together, enters sub menu pages.
3. **PAUSE & UP** keys pressed together, exits sub menus to the parent menu pages.
4. **UP** key selects the previous menu page, sub menu page, alarms, and increments data.
5. **DOWN** key selects the next menu page, sub menu page, alarms, and also decrements data.
6. **ENTER** key sends data to the automation equipment, accepts alarms, and displays accepted alarms.
7. **ALPHANUMERIC KEYPAD** and **PROGRAMMABLE KEYS** can be used to enter data or can be used to preform some pre-programmed action.

2.1.2 **CTIU050 Contrast Adjustment**

On menu page 1 (after the start-up screen), hold the **ENTER** key and press the **UP** or **DOWN** key to adjust the contrast. The contrast setting is stored and **not** lost after removing power.

---

**Figure 2.1 – Front View of CTIU050**

[Diagram of CTIU050 showing button locations]
2.2. CTIU050 Ports

Pin 1     CTIU050 8-pin Terminal Block     Pin 8

Figure 2.2 Automation Equipment Serial Port

<table>
<thead>
<tr>
<th>Tx+</th>
<th>Tx-</th>
<th>Rx+</th>
<th>Rx-</th>
<th>TxD</th>
<th>0V</th>
<th>RxD</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>RS422/485</td>
<td>RS232</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2.2.1 CTIU050 Configuration of the RS-485 Port

Figure 2.3 – PC Programming Serial Port
The Serial Pin connections for transmit (Tx), receive (Rx) and ground are displayed above.

Figure 2.4 – Power Connector
Powered by +24VDC and Ground.

Figure 2.5 – Configuration Bank
The configuration bank (shown in Figure 2.5) sets the parameters of the RS-485 port as described in Table 2.1.

<table>
<thead>
<tr>
<th>Switch 1</th>
<th>ON: Pull-up (must be used together with switch 3)</th>
<th>OFF: no Pull-up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch 2</td>
<td>ON: 120Ω termination</td>
<td>OFF: no termination</td>
</tr>
<tr>
<td>Switch 3</td>
<td>ON: Pull-down (must be used together with switch 1)</td>
<td>OFF: no Pull-down</td>
</tr>
<tr>
<td>Switch 4</td>
<td>Reserved for future use</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Switch 1 and 3 must be used together. Either both pull-up and pull-down are used or neither is used.

Pull-up and Pull-down switches are used to increase the signal level on the RS-485 bus. This is useful if there is a long bus and a significant amount of attenuation is anticipated.

Termination resistance of 120Ω must be placed across each end of the RS-485 bus. With switch 2 ON, a 120Ω resistance is placed across the bus. This is only used if the CTIU050/100/110 is the last device at either end of the bus.

### 2.2.2 CTIU050 Dimensions

![CTIU050 Cutout](image)

**CTIU050 CUTOUT DETAILS**

TOLERANCES ARE +/- 0.01" [0.3mm] UNLESS STATED OTHERWISE

**Figure 2. 6 – CTIU050 Cutout**
3. CTIU100/101

3.1. General

3.1.1 CTIU100 Button Selection Actions

1. PAUSE key selects data for editing OR exits from data editing.
2. PAUSE & DOWN keys pressed together, enters sub menu pages.
3. PAUSE & UP keys pressed together, exits sub menus to the parent menu pages.
4. UP key selects the previous menu page, sub menu page, alarms, and increments data.
5. DOWN key selects the next menu page, sub menu page, alarms and also decrements data.
6. ENTER key sends data to the automation equipment, accepts alarms, and displays accepted alarms.

3.1.2 CTIU100 Contrast Adjustment

On menu page 1 (after the start-up screen), hold the ENTER key and press the UP or DOWN key to adjust the contrast. The contrast setting is stored and not lost after removing power.
3.2. CTIU100 Rear View

3.2.1 CTIU100 Ports

Figure 3.2 – Rear View of CTIU100/110

Figure 3.3 – Automation Equipment Serial Port
3.2.2 CTIU100 Configuration of the RS-485 Port

The configuration bank (shown in Figure 3.8) sets the parameters of the RS-485 port as described in Table 3.1.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch 1</td>
<td>ON: Pull-up (must be used together with switch 3)</td>
</tr>
<tr>
<td></td>
<td>OFF: no Pull-up</td>
</tr>
<tr>
<td>Switch 2</td>
<td>ON: 120Ω termination</td>
</tr>
<tr>
<td></td>
<td>OFF: no termination</td>
</tr>
<tr>
<td>Switch 3</td>
<td>ON: Pull-down (must be used together with switch 1)</td>
</tr>
<tr>
<td></td>
<td>OFF: no Pull-down</td>
</tr>
<tr>
<td>Switch 4</td>
<td>Reserved for future use</td>
</tr>
</tbody>
</table>

**NOTE:** Switch 1 and 3 must be used together. Either both pull-up and pull-down are used or neither is used.

Pull-up and pull-down switches are used to increase the signal level on the RS-485 bus. This is useful if there is a long bus and a significant amount of attenuation is anticipated.

![Figure 3.6 – PC Programming Serial Port](image)

The Serial Pin connections for transmit (Tx), receive (Rx) and ground are displayed above.
Termination resistance of 120Ω must be placed across each end of the RS-485 bus. With switch 2 ON, a 120Ω resistance is placed across the bus. This should only be used if the CTIU050/100/110 is the last device at either end of the bus.

3.3. CTIU10X Dimensions

![CTIU10X Cutout Diagram]

CTIU10X CUTOUT DETAILS
TOLERANCES ARE +/- 0.01" [0.3mm] UNLESS STATED OTHERWISE

Figure 3.9 – CTIU10X Cutout
4. **CTIU110/111**

4.1. **General**

4.1.1 **CTIU110 Button Selection Actions**

1. **PAUSE** key selects data for editing OR exits from data editing.
2. **PAUSE & DOWN** keys pressed together, enters sub menu pages.
3. **PAUSE & UP** keys pressed together, exits sub menus to the parent menu pages.
4. **UP** key selects the previous menu page, sub menu page, alarms, and increments data.
5. **DOWN** key selects the next menu page, sub menu page, alarms and also decrements data.
6. **ENTER** key sends data to the automation equipment, accepts alarms, and displays accepted alarms.
7. **ALPHANUMERIC KEYPAD** and **PROGRAMMABLE KEYS** can be used to enter data or can be used to preform some pre-programmed action.

4.1.2 **Contrast Adjustment**

On menu page 1 (after the start-up screen), hold the **ENTER** key and press the **UP** or **DOWN** key to adjust the contrast. The contrast setting is stored and not lost after removing power.

Figure 4.1 – Front View of CTIU110
4.2. CTIU110 Rear View

4.2.1 CTIU110 Ports

Figure 4.2 – Rear View of CTIU100/110

Figure 4.3 – Automation Equipment Serial Port
Figure 4.4 – Automation Equipment Port Receive & Transmit LEDs
The LED’s flash when the CTIU100/110 is communicating.

Figure 4.5 – PC Port Receive & Transmit LEDs
The LED’s flash when the PC is communicating with the CTIU100/110

Figure 4.6 – PC Programming Serial Port
The Serial Pin connections for transmit (Tx), receive (Rx) and ground are displayed above.

Figure 4.7 – Power Connector
Powered by +24VDC and Ground.

Figure 4.8 – Configuration Bank
4.2.2 **CTIU110 Configuration of the RS-485 Port**

The configuration bank (shown in Figure 4.8) sets the parameters of the RS-485 port as described in Table 4.1.

<table>
<thead>
<tr>
<th>Switch 1</th>
<th>ON: Pull-up (must be used together with switch 3)</th>
<th>OFF: no Pull-up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch 2</td>
<td>ON: 120Ω termination</td>
<td>OFF: no termination</td>
</tr>
<tr>
<td>Switch 3</td>
<td>ON: Pull-down (must be used together with switch 1)</td>
<td>OFF: no Pull-down</td>
</tr>
<tr>
<td>Switch 4</td>
<td>Reserved for future use</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Switch 1 and 3 must be used together. Either both pull-up and pull-down are used or neither is used.

Pull-up and Pull-down switches are used to increase the signal level on the RS-485 bus. This is useful if there is a long bus and a significant amount of attenuation is anticipated.

Termination resistance of 120Ω must be placed across each end of the RS-485 bus. With switch 2 ON, a 120Ω resistance is placed across the bus. This should only be used if the CTIU050/100/110 is the last device at either end of the bus.

4.3. **CTIU11X Dimensions**

5.95" [151mm]

3.27⁺0.02⁻0.00 [83⁺0.5⁻0.0 mm]

**CTIU11X CUTOUT DETAILS**

TOLERANCES ARE +/- 0.01" [0.3mm] UNLESS STATED OTHERWISE

**Figure 4.9 – CTIU11X Cutout**
5. CTIU 200

5.1 5.1 General

5.1.1 CTIU20X Button Selection Actions

1. **PAUSE** key selects data for editing OR exits from data editing.
2. **PAUSE & DOWN** keys pressed together, enters sub menu pages.
3. **PAUSE & UP** keys pressed together, exits sub menus to the parent menu pages.
4. **UP** key selects the previous menu page, sub menu page, alarms, and increments data.
5. **DOWN** key selects the next menu page, sub menu page, alarms and also decrements data.
6. **ENTER** key sends data to the automation equipment, accepts alarms, and displays accepted alarms.
7. **ALPHANUMERIC KEYPAD** can be used to enter data.
8. **PROGRAMMABLE KEYS** can be used to preform some pre-programmed action.

5.1.2 Contrast Adjustment

On menu page 1 (after the start-up screen), hold the **ENTER** key and press the **UP** or **DOWN** key to adjust the contrast. The contrast setting is stored and not lost after removing power.
5.2. CTIU20X Rear View

Figure 5.2 – Rear View of CTIU20X

5.2.1 CTIU20X Ports

Pin 1  CTIU20X 8-pin Terminal Block  Pin 8

Figure 5.3 Automated Equipment Serial
Figure 5.4 – Automation Equipment Port Receive & Transmit LEDs
The LED’s flash when the CTIU100/110 is communicating.

Figure 5.5 – PC Port Receive & Transmit LEDs
The LED’s flash when the PC is communicating with the CTIU100/110.

Figure 5.6 – PC Programming Serial Port
The Serial Pin connections for transmit (Tx), receive (Rx) and ground are displayed above.

Figure 5.7 – Power Connector
Powered by +24VDC and Ground.

Figure 5.8 – Configuration Bank
5.2.2  CTIU20X Configuration of the RS-485 Port

The configuration bank (shown in Figure 2.23) sets the parameters of the RS-485 port as described in Table 5.1.

<table>
<thead>
<tr>
<th>Switch 1</th>
<th>ON: Pull-up (must be used together with switch 3)</th>
<th>OFF: no Pull-up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch 2</td>
<td>ON: 120Ω termination</td>
<td>OFF: no termination</td>
</tr>
<tr>
<td>Switch 3</td>
<td>ON: Pull-down (must be used together with switch 1)</td>
<td>OFF: no Pull-down</td>
</tr>
<tr>
<td>Switch 4</td>
<td>Reserved for future use</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Switch 1 and 3 must be used together. Either both pull-up and pull-down are used or neither is used.

Pull-up and Pull-down switches are used to increase the signal level on the RS-485 bus. This is useful if there is a long bus and a significant amount of attenuation is anticipated.

Termination resistance of 120Ω must be placed across each end of the RS-485 bus. With switch 2 ON, a 120Ω resistance is placed across the bus. This should only be used if the CTIU050/10X/11X/20X is the last device at either end of the bus.

5.3.  CTIU20X Dimensions

![CTIU20X Cutout Diagram]

CTIU20X CUTOUT DETAILS

TOLERANCES ARE +/- 0.01" [0.3mm] UNLESS STATED OTHERWISE

**Figure 5.9 – CTIU20X Cutout**
6. COMMUNICATIONS

6.1. Connection of Control Techniques devices

6.1.1 4 wire RS422/485 to UD71, Mentor, UD70, MD29, CDE, MC204

The ANSI (with menus) protocol using 4 wire RS485 has been supported by most of Control Techniques’ products since the introduction of Mentor II. The only recent products not supporting 4 wire are Diverter A and Commander SE.

The modbus protocol on the UD70 series MD29 and MD29AN also uses this connection.

For multi drop connections simply connect the CT slave device connections in parallel.

---

Figure 6.1 Wiring for CT devices using 4 wire RS422/485
6.1.2  RS-485 Two-Wire to UD7#, commander SE and Diverter A

This is the electrical standard for ANSI (with menus) protocol and Modbus using 2 wire RS485 & is supported by Control Techniques’ more recent products.

CTIU110/100

CTIU050/200

RJ45 connector on Commander SE
(Substitute this for the 9 way connections shown above)

Terminal strip on Diverter A
(Substitute this for the 9 way connections shown above)

Pin 1 0V (isolated)
6.1.3 **RS232 to UD71, UD7#**

This electrical connection is used by the ANSI protocol on UD71 when RS232 is needed. It is also used by the MD29MON protocol on the UD7# (not UD71), MD29 and MD29AN.

![CTIU110/100 Diagram](image1)

CTIU050/200

![CTIU050/200 Diagram](image2)

![CTNet Wiring Diagram](image3)

6.1.4 **CTNet wiring guidance**

Refer to chapter 16 for fitting details of CTNet SmartStack adapter. This protocol & hardware is supported by MD29AN and UD75. A 78Ω termination resistor will be required between Tb1 & Tb2 if the CTIU is the last node on the bus. Refer to CTNet manual for further information on wiring, cable lengths etc.
6.1.5 Recommended Automation Equipment Communication Cables

Control Techniques recommends the following cables for drive and other automation equipment communications using RS485:

Belden No. 8105, 9807 or 9832 – General Purpose

**Belden No. 8165 – Heavy Noise Environment**

For CTNet a special tested cable is available from Control Techniques, with part numbers:

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSP-3000-0050</td>
<td>50m Reel</td>
</tr>
<tr>
<td>SSP-3000-0100</td>
<td>100m Reel</td>
</tr>
<tr>
<td>SSP-3000-0200</td>
<td>200m Reel</td>
</tr>
</tbody>
</table>

6.2. Control Techniques Device Setup & Usage Details

6.2.1 Control Techniques ANSI comms protocol and the CTIU: Generalities.

- The unit uses Unidrive address rules so group addressing is supported; this means that the default address (1) for mentor will not work with the unit. Mentors will need to be re-addressed to Unidrive legal numbers (11-19, 21-29, 31-39 etc).
- All parameters passed to and from the drive are handled by the CTIU as integers i.e. value 45.4 becomes 454 for reads (vice versa for writes) this is important when using the scaling facilities, text lookups etc. Usually numerical drive parameters should be accessed as signed 16 bit, (unsigned may be used if required but take care with range).
- When using the ANSI protocol, the unit can talk to 32bit virtual menus in the UD70 / MD29 but these will read as signed or unsigned 16 bit numbers – take care with the range used. Alternatively 32 bit access can be turned on in the embedded field dialog in which case the unit will look for 2 consecutive registers. treating the first as least significant 16 bits and the second as most significant 16 bits, these two are then combined to give a signed or unsigned 32 bit number. This feature cannot be used with menus 18, 19 & 20 as values are restricted to +/- 32000.
- When using the Modbus RTU or ASCII protocol only 16 bit transfers are supported by CT devices, The CTIU supports 32 bit transfers consequently do not select 32 bit transfers for any field on the CTIU when using Modbus.
- When using the MD29MON protocol or CTNet 32bit registers in the PLC or other virtual menu area will be read as 32 bit in a single transaction.
- Group broadcast may be used provided drive 1 in the particular group exists (Unidrive only).
- Global broadcast may be used by sending to address 0 provided drive 11 exists. Mentor broadcast is supported in this mode but the first drive must be address 11, other drives should follow Unidrive address rules. With care mixed (Unidrive & Mentor) networks can be supported for broadcast in this mode but all broadcast parameters should be integer.
- For CTNet communications using a CTIU 200 an optional CTNet SmartStack module is required.

6.2.2 CTNet (UD75)

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#20.01</td>
</tr>
<tr>
<td>Speed (Kb/s)</td>
<td>#20.02</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 255</td>
</tr>
<tr>
<td>0 = 5 Mb/s, 1 = 2.5 Mb/s .... 312.5Kb/s</td>
</tr>
</tbody>
</table>
### 6.2.3 CTNet (MD29AN)

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#14.05</td>
<td>1 - 255</td>
</tr>
<tr>
<td>Speed (Kb/s)</td>
<td>#11.01</td>
<td>0 = 5 Mb/s, 1 = 2.5 Mb/s …. 312.5Kb/s</td>
</tr>
</tbody>
</table>

### 6.2.4 Mentor drive

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#11.11</td>
<td>Use Unidrive address rules (see note above)</td>
</tr>
<tr>
<td>Speed (Kb/s)</td>
<td>#11.12</td>
<td>0 = 4.8, 1=9.6</td>
</tr>
<tr>
<td>Mode</td>
<td>#11.13</td>
<td>Must be set to 1</td>
</tr>
</tbody>
</table>

### 6.2.5 MD29

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#14.01</td>
<td>Uses Unidrive address rules</td>
</tr>
<tr>
<td>Mode</td>
<td>#14.02</td>
<td>1 = 4 wire ansi, 5 = 2 wire ansi, 13 = Modbus RTU 14 = Modbus ASCII.</td>
</tr>
<tr>
<td>Speed (Kb/s)</td>
<td>#14.03</td>
<td>Enter 1st 2 digits of required speed (1st only for speeds &lt; 1000)</td>
</tr>
</tbody>
</table>

Parameters given for Mentor only, please check documentation for CDE, older MD29 capable CT drives are not supported

### 6.2.6 Unidrive + UD71

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#11.23</td>
<td>Uses Unidrive address rules</td>
</tr>
<tr>
<td>Mode</td>
<td>#11.24</td>
<td>0 = 2 wire ansi, 1 = 4 wire ansi</td>
</tr>
<tr>
<td>Speed (Kb/s)</td>
<td>#11.25</td>
<td>0 = 4.8, 1=9.6, 2 = 19.2</td>
</tr>
</tbody>
</table>

### 6.2.7 Unidrive + UD7# (not UD71)

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#14.01</td>
<td>Uses Unidrive address rules</td>
</tr>
<tr>
<td>Mode</td>
<td>#14.02</td>
<td>1 = 4 wire ansi, 5 = 2 wire ansi, 13 = Modbus RTU 14 = Modbus ASCII.</td>
</tr>
<tr>
<td>Speed (Kb/s)</td>
<td>#14.03</td>
<td>Enter 1st 2 digits of required speed (1st only for speeds &lt; 1000)</td>
</tr>
</tbody>
</table>

### 6.2.8 Commander SE

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#11.23</td>
<td>Uses Unidrive address rules</td>
</tr>
<tr>
<td>Mode</td>
<td>#11.24</td>
<td>0 = 2 wire ansi, 1 = Modbus RTU</td>
</tr>
<tr>
<td>Speed (Kb/s)</td>
<td>#11.25</td>
<td>0 = 4.8, 1=9.6, 2 = 19.2</td>
</tr>
</tbody>
</table>

### 6.2.9 CDE

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#11.23</td>
<td>Uses Unidrive address rules</td>
</tr>
<tr>
<td>Mode</td>
<td>#11.24</td>
<td>0 = 4 wire ansi,</td>
</tr>
<tr>
<td>Speed (Kb/s)</td>
<td>#11.25</td>
<td>0 = 4.8, 1=9.6, 2 = 19.2</td>
</tr>
</tbody>
</table>

### 6.2.10 Dinverter

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>#b.23</td>
<td>Uses Unidrive address rules</td>
</tr>
<tr>
<td>Mode</td>
<td>Fixed 2 wire ANSI</td>
<td></td>
</tr>
<tr>
<td>Speed</td>
<td>Fixed at 4800</td>
<td></td>
</tr>
</tbody>
</table>

Menus a – f are not available to the CTIU.
6.3. MC204 / 216

Although an ANSI program is available for the MC controller, we recommend the use of Modbus protocol for the MC controller as it is simpler to set up.

To set up MODBUS RTU with MC2##

To set up the motion controller you need to execute 2 lines of basic.

ADDRESS = n

Where n is the number of the node

SETCOM(baudrate, databits, stopbits, parity,[port number],[control])

Parameters        Settings
baudrate:          1200, 2400, 4800, 9600, 19200 or 38400
databits:          7 or 8
stopbits:          1 or 2
parity:            0=none, 1=odd, 2=even
port number:       0, 1 or 2 (If not specified this parameter defaults to 0)
control:           On channel #1 XON/XOFF can be made active or disabled: active, 0=off.
                   Setting value 4 activates the MODBUS RTU mode.

Note: On power up the controllers always set the serial ports to 9600, 7, 2, even, XON/XOFF active.

Suggested settings:

ADDRESS = 1
SETCOM(19200, 8, 1, 0, PORT_No , 4)

With MC204

For RS232 Port_No should be 1
For RS485 Port_No. Should be 2

Limitations:

MC204 and MC202 can only support the protocol at baud rates up to 19200.

Version 1.48 of the MC system file can only handle 16 bit-unsigned variables, the next version of the system file will fix this problem.
6.4. Other Automation Equipment (AE) Communications Connections

6.4.1 RS-232 Connection

![Diagram of RS-232 Connections]

**Figure 6.5 – RS-232 Connection for other equipment**

*Note: Ground Connections at Both Ends.*
6.4.2 6.3.2 RS-422/485 Four-Wire

**CTIU110/100**

RS422/485 (4-wire)

(Section of 13-pin Terminal Block)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx+</td>
<td>2</td>
</tr>
<tr>
<td>Tx-</td>
<td>3</td>
</tr>
<tr>
<td>Rx+</td>
<td>4</td>
</tr>
<tr>
<td>Rx-</td>
<td>5</td>
</tr>
<tr>
<td>TxD</td>
<td>6</td>
</tr>
<tr>
<td>0V</td>
<td>7</td>
</tr>
<tr>
<td>RxD</td>
<td>8</td>
</tr>
</tbody>
</table>

AE (Examples)

GE

RXA RDA IN+ RDB
RXB RDB IN- RDA
TXA SDA OUT+ SDB
TXB SDB OUT- SDA

SG 0V GND COM

0.1uF Ceramic

**CTIU050/200**

RS422/485 (4-wire)

(Section of 8-pin Terminal Block)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx+</td>
<td>1</td>
</tr>
<tr>
<td>Tx-</td>
<td>2</td>
</tr>
<tr>
<td>Rx+</td>
<td>3</td>
</tr>
<tr>
<td>Rx-</td>
<td>4</td>
</tr>
<tr>
<td>TxD</td>
<td>5</td>
</tr>
<tr>
<td>0V</td>
<td>6</td>
</tr>
<tr>
<td>RxD</td>
<td>7</td>
</tr>
</tbody>
</table>

AE (Examples)

GE

RXA RDA IN+ RDB
RXB RDB IN- RDA
TXA SDA OUT+ SDB
TXB SDB OUT- SDA

SG 0V GND COM

0.1uF Ceramic

**Figure 6.6 – RS-422/485 4**

**Note:** The descriptions used by different manufacturers for RS-422/485 connections vary. Please refer to the automation equipment manufacturers own manuals for connection details.
6.3.3 RS485 2 wire

Figure 6.7 – RS-485 Two-wire
7. GETTING STARTED

7.1. Self-Test
Power up the unit with the UP and ENTER keys pressed at the same time. The unit enters a self-test mode. The self-test consists of the following four checks:

Contrast Band
This test allows the user to set the lower and upper limits of contrast. Adjust the lower limit using the UP or DOWN key and press Enter when done. Do the same for the upper limit.

Display Test
The display test continuously blinks all pixels on (black) to off. Look for any pixels stuck on or off. Exit this test by pressing and holding any key for approximately two seconds.

Keyboard Test
As each key is pressed, an indication *** appears above that key. In the case of units with a numeric keypad, press the key and a message appears indicating the key press. Check for keys indicating multiple presses or not reporting presses. Exit this test by pressing and holding any key for approximately two seconds.

RAM Test
Test either segment 0000 or segment 1000 (on the CTIU100/110) of the RAM. The segment 1000 test performs a base 3 repeating test. This test detects shorted address lines and damaged memory bits. The segment 0000 test performs a Read-Modify-Write test on each byte of RAM, detecting damaged memory bits. Exit this test by selecting DONE.

7.2. Serial Loop-back Tests
Tests the PC port and the Serial Port in each of it's three modes for serial loop-back. Pre-made plugs are required to link the pins of a particular port. This takes the following form:

<table>
<thead>
<tr>
<th>Port Tested</th>
<th>Product</th>
<th>Type of Connector</th>
<th>Pins to Short</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC (J2)</td>
<td>CTIU100/110</td>
<td>Pin male D link connector</td>
<td>pin 2 to pin 3</td>
</tr>
<tr>
<td>RS-232 (J3)</td>
<td>CTIU100/110</td>
<td>13-pin phoenix connection</td>
<td>pin 6 to pin 8</td>
</tr>
<tr>
<td>RS-422/485 (J3)</td>
<td>CTIU100/110</td>
<td>13-pin phoenix connection</td>
<td>pin 2 to pin 4 and pin 3 to pin 5</td>
</tr>
<tr>
<td>Current Loop</td>
<td>CTIU100/110</td>
<td>13-pin phoenix connection</td>
<td>pin 1 to 9, pin 10 to 11 and pin 12 to 7</td>
</tr>
<tr>
<td>PC</td>
<td>CTIU050</td>
<td>Pin male D link connector</td>
<td>pin 2 to pin 3</td>
</tr>
<tr>
<td>RS-232</td>
<td>CTIU050</td>
<td>8-pin phoenix connection</td>
<td>Pin 5 to pin 7</td>
</tr>
<tr>
<td>RS-422/485</td>
<td>CTIU050</td>
<td>8-pin phoenix connection</td>
<td>Pin 1 to pin 3, Pin 2 to pin 4</td>
</tr>
</tbody>
</table>

**NOTE:** current loop in not installed on standard models, as such a standard model will fail the current loop-back test. Current Loop is not an option on the CTIU050/20X.

After starting the test, the OK counter begins to count up. Exit this test by selecting DONE.
7.3. Selecting the Automation Equipment

The following points are covered in this section:

a. Connecting a PC to the CTIU050/100/110/20X;
b. Choosing the drive or PLC connected to the CTIU050/100/110/20X see also sec 6.2.
c. Selecting the protocol to be used.

1. Install the `<CTIU>` software on your PC (if not already done). Double-click on `<CTIU>` Software icon; and the default screen shown below appears.

![Default Screen](image)

2. From `<Configure>`, p

3. Connect the CTIU050/10X/11X/20X (PC Port) to a serial (COM1, 2, 3 or 4) on the PC. From the `<Configure>` menu, choose `<PC Comms Port>` and the applicable Comm port.

4. Connect power (+24VDC) to the CTIU050/10X/11X/20X. Power-up the unit. The type of protocol currently installed is displayed in the lower half of the screen during power-up.

5. If the automation equipment is different than the protocol currently installed on the CTIU050/100/110/20X, a new protocol must be loaded.
6. From the **Configure** menu, click **Communication Settings** and select manufacture of the automation equipment, followed by the type. The default setting for this equipment will be displayed in the window. Click **OK** to accept.

7. **ANSI**
If the default setting does not match the communications settings of the automation equipment, select the appropriate **Baud Rate**, and **Communication Mode** (see below, for CT equipment the **Parity**, **Data Bits**, **Stop Bits do not need to be changed**). See figure 7.2.

**CTNet**
Simply select the Baud rate appropriate for the network you are going to connect to and the HMI node address for the CTIU unit. In most cases the default value of 255 will be appropriate and will only need to be changed if another unit is already using this address. Both

*If you are connecting to a single node* enter the appropriate **Global Remote Node ID** leaving **network mode** unchecked. For multidrop installations check the box and you will need to enter the required node for each embedded field on your display.

---

**Figure 7.2 – AE Configuration Boxes showing ANSI & CTNet setups**
8. To update the protocol, select **File**, then **Update TIU Protocol**. The programming tool should select the correct folder for you. (Older versions did not select this folder automatically; the default path is C:\Program files\control techniques\CTIU\protocols\(0xx, 1xx, or 2xx for 50, 100 or 200). The appropriate file for the selected the automation equipment, will be displayed in the file name window. Click **OK**. A “**SYSTEM SHUTDOWN**” message appears on the CTIU050/10X/11X/20X.

9. Once this is done you can change comms speeds, address etc without having to download the protocol again. These details are also downloaded with the screen configuration, and so can be easily changed.

7.4. **Details for setting up standard serial comms**

7.4.1 **Communication Mode settings available for standard serial comms.**

The TiU is capable of operating in a number of electrical standards and the communication mode selection box is used to indicate which should be used. The selection made effects only the electrical standard used to implement the serial link, not the data so transferred. i.e. selecting modbus and RS422/485 Four Wire (TiU Slave) does not make the unit function as a modbus slave, merely as a master whose transmitters are turned off when not transmitting.

The modes supported are...

**RS422/485 Four Wire (TiU Master)**

Both the RS422 transmitters and the receivers are permanently enabled. Choose this option where the connected device uses a four wire link and the TiU is the master on the link.

**RS232**

Choose this option where a basic three wire RS232 link is required with no handshaking.

**RS485 Two Wire**

Here the RS422 transmitters are enabled only when the terminal is sending data. The receivers are switched off when transmitting but switched on at all other times. Choose this setting when using a two wire RS485 link.

**Current Loop**

Here the current loop receiver and transmitter are permanently enabled. The current loop option requires a pair of current loop driver chips to be fitted to the terminal. Some terminals are not capable of upgrade. (Only TiU100 and TiU110 are) Choose this setting when the device to be connected to has a current loop interface (Also described as 4-20 mA loop interface).

**RS422/485 Four Wire (TiU Slave)**

The RS422 transmitter is enabled whenever data is being transmitted but the receivers are permanently enabled. Choose this option where the connected device uses a four wire link, but the TiU is one of a number of slaves on the link.

**RS232 With Active CTS**

Here the RS422 Rx Input is treated as a clear to send. This is achieved by tying Rx+ (RS422) To 0V and feeding the CTS input into Rx- (RS485). Use RS232 transmit and receive as normal. Use this option where the slave device is slow and will switch off CTS to indicate it is not ready to accept data.

7.4.2 **Protocol selection details for Control Techniques devices.**

Devices not supported:
Any older CT drive not using a Mentor II style menu & parameter set, this includes

- All vector product prior to Unidrive
- Commander CD / CD2 open loop drives (the New Commander SE is supported)
- Mentor 1
- Spindax
- Dynamax
- Digitax
- Dominax
- Diverter B

Summary protocol details for supported devices are given below

<table>
<thead>
<tr>
<th>Device</th>
<th>Protocols supported</th>
<th>baud rate range</th>
<th>Electrical mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mentor II</td>
<td>ANSI328, Modbus RTU, Modbus ASCII, MD29MON</td>
<td>4.8 – 9.6 Kb/s</td>
<td>RS485</td>
</tr>
<tr>
<td>Md29</td>
<td>ANSI328, Modbus RTU, Modbus ASCII, MD29MON</td>
<td>0.3 – 38.4 Kb/s</td>
<td>RS485 (not MD29MON)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RS232 (MD29MON only)</td>
</tr>
<tr>
<td>UD71</td>
<td>ANSI328</td>
<td>4.8 – 19.2 Kb/s</td>
<td>RS485, RS232</td>
</tr>
<tr>
<td>Other UD7#</td>
<td>ANSI328, Modbus RTU, Modbus ASCII, MD29MON</td>
<td>0.3 – 38.4 Kb/s</td>
<td>RS485 (not MD29MON)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RS232 (MD29MON only)</td>
</tr>
<tr>
<td>CDE</td>
<td>ANSI328</td>
<td>4.8 – 19.2 Kb/s</td>
<td>RS485</td>
</tr>
<tr>
<td>MC204 / 216</td>
<td>ANSI328, Modbus RTU</td>
<td>4.8 – 19.2 Kb/s</td>
<td>RS485, RS232</td>
</tr>
<tr>
<td>Diverter A</td>
<td>ANSI328 (2 wire only)</td>
<td>4.8 Kb/s</td>
<td>RS484 2 wire only</td>
</tr>
<tr>
<td>Commander SE</td>
<td>ANSI328 (2 wire only), Modbus RTU</td>
<td>2.4 – 19.2 Kb/s</td>
<td>RS484 2 wire only</td>
</tr>
</tbody>
</table>

Refer to chapter 6 for further setup details for CT devices

Where available you should choose Modbus RTU (it is more efficient then ANSI) which you will find in the Miscellaneous manufacturer section of the comms setup dialogue. Select 2 or 4 wire from the communications mode menu (2 wire Modbus with UD7# / MD29 is supported from V2.8 firmware onwards).

If you use ANSI in 4 wire mode (or RS232 with UD71) then choose ANSI 4 wire (On CTIU software prior to May 2000 this protocol is denoted as Unidrive or Mentor), from the remote equipment model menu in the dialogue. If you are using 4 wire this will also support the CDE. Then select either RS422/485 4 wire (TIU master) or RS232 in the communications mode menu.

If you use ansi in 2 wire mode then choose “2 wire RS485 ANSI 328” this supports all the 2 wire products. Then select RS485 2 wire in the communications mode menu.

7.4.3 Choice of data rate

The maximum data exchange rate available depends on the device in use and varies between 9600Kb/s up to 38400 Kb/s at the time of writing. With the recommended cable and correct installation the best choice of speed is the fastest available on the device. With UD70 & MD29 38400 is available but when the processor is heavily loaded for instance when running position control plus an extensive user control program there may not be enough resource in the second processor to service the serial port at this speed in which case use 19200Kb/s.
7.5.  **Proving Communications**

Connect the CTIU050/10X/11X/20X to the automated equipment using the cable drawing provided.

![CTIU Configuration Package](image)

Figure 7.3 – Start-up

The following steps verify communications between the CTIU050/10X/11X/20X and the automation equipment. The figures shown here are for the CTIU100. Methods are exactly the same for the all products in the TIU range.
1. Click on the Wizards Icon in the tool bar and choose Comms Stats. The display should then look like figure 7.3. Move the cursor to the line of dashes at the bottom of the screen about 5 characters in and double click, you are presented with an array of pushbuttons, click the top left one, and the dialog below should open.

![Configure Numeric Embedded Data](image)

**Figure 7.4 – Numeric data dialogue**

Fill it in as shown. This will ensure that the CTIU polls the drive for data. Click Ok and you should have a screen looking like figure 7.5

2. The settings can be saved. To do this, select Save Project As from File. Enter a file name and click OK.

3. Download the project to the CTIU050/100/110. To do this, from the File menu select Download Project to Tiu. A status bar appears indicating the progress of the download. On the CTIU050/10X/11X/20X Display Screen, “SYSTEM SHUTDOWN” appears. A message of “Transfer Complete” appears when the data has been successfully downloaded.

**Note:** If the error “Link Failed” appears, check the cable connection between the PC and CTIU050/10X/11X/20X.
4. After the transfer, the CTIU050/10X/11X/20X resets itself and the correct automation equipment type is shown temporarily on the Display Screen.

5. On the Display Screen, the “GOOD” number of communications should be equal to the “TOTAL” number of communications. The content of the embedded data, on the top line, depends on the existing data in that register of the PLC.

7.6. Icon Descriptions

The CTIU050/10X/11X/20X software main screen is shown in Figure 7.4. Along the top are several short cut icons. Many are standard Windows™ icons, some however, are specific to the CTIU, these are labeled.

Figure 7.5 Toolbar icons
7.7. **Up/Down Keys**

*Left clicking* on the “Up” and “Down” keys on the project window has the same effect as “Up” and “Down” key presses (i.e., scroll up/down through the current menus). *Right clicking* on the “Up” and “Down” keys on the project window have the same effect as Ctrl-Page Up and Ctrl-Page Down key presses (i.e., enter sub menu, and leave sub-menu, respectively). If a sub-menu does not exist a message appears saying “This page does not have a sub-menu, would you like to create one?” See Creating a sub-menu later in this manual.

7.8. **Key Symbols**

The symbols for the four keys can be added to display pages using the PC function keys F2-F5. The keys are assigned as follows:

1. F2 = PAUSE
2. F3 = UP
3. F4 = DOWN
4. F5 = ENTER
8. ABOUT PROJECTS

8.1. General

This chapter describes the procedure for configuring the CTIU050/10X/11X/20X. This includes loading, saving, downloading, uploading, verifying and updating the protocol.

8.2. About TIU Terminal

This new feature allows the programmer to see what version level the connected terminal is at and how it is configured. The information given is:

a. Operating System Version Level
b. Firmware Version Level
c. Protocol Version Level
d. Remote Equipment Manufacturer
e. Remote Equipment Model

This can be used as a useful diagnostic tool when updating operating system and firmware.

From the main menu click Help/About TIU Terminal, a window similar to Fig 8.1 appears.

![Figure 8.1 About TIU Terminal Configuration](image)

8.3. Creating a New Project

1. Select New from the File menu.
2. The following error message appears:

![Figure 8.1 – New Project](image)

3. Click OK.
8.4. Opening a Project

1. Press the “open folder” icon on the program display screen or select **Open Project** from the **File** menu.
2. Select the proper file name from the list of available projects (with “cmc” extension).
3. Click **OK**.

8.5. Saving a Project

1. If the project has been previously saved during the current session, press the “floppy” disk icon on the program display screen or select **Save Project** from the **File** menu.
2. If this is the first time saving this project to a file, select **Save Project As** from the **File** menu.
3. Enter the file name and destination. Click **OK**.

8.6. Downloading a Project

8.6.1 General

Prior to the download the software checks if following conditions are correct:

a) The correct TIU terminal is connected to the PC.
b) Checks the correct Protocol file is loaded to the terminal.
c) Checks the current revision operating system and firmware revision.

**Note:** If the message “Link Failed” appears, check the cables connecting the PC to the unit.

**Note:** If the message “This Terminal is fitted with the incorrect PLC protocol. Load the correct protocol before loading the configuration into the terminal”. The project and the terminal are not set-up for the same protocol. If the project is correct then download the correct protocol file to the TIU.

1. Select **Download Project** from the **File** menu. A status bar appears; indicating the download is in progress.
2. After the project has been downloaded, the message **“Transfer Complete”** appears.
3. After the transfer, the CTIU050/10X/11X/20X resets itself.
4. The downloaded project now runs.

8.7. Uploading a Project

1. Select **Upload Project** from the **File** menu.
2. A status bar appears; indicating the upload is in progress.

**Note:** If the message “Link Failed” appears, check the cables connecting the PC to the unit.

3. After the project has been uploaded, the message **“Transfer Complete”** appears.

8.8. Verifying a Project

1. Select **Verify Project** from the **File** menu.
2. A status bar appears indicating verification progress.
8.9. Updating the Protocol

When the software is installed the user decides where the main CTIU folder resides. The default structure when this manual was printed is:

![Diagram of folder structure]

8.9.1 Directory descriptions
- **Fonts**: Default store for CTIU font definitions
- **OS**: The 3 CTIU operating system files are stored here (auto-selected by program)
- **Projects**: Use this for your project files
- **Protocol**: The various drive & PLC communication protocol files are in here.
  - TIU0xx files for the CTIU050
  - TIU1xx files for the CTIU100/110
  - TIU2xx files for the CTIU200

8.9.2 Changing Protocols

In the protocol directory 3 folders are created, TIU0xx, TIU1xx and TIU2xx. The protocol files for the different terminal are loaded into these folders. The protocol files for the CTIU050 are loaded into TIU0xx, the protocol files for the CTIU10X are loaded into TIU10x and the protocol files for the CTIU20X are loaded into TIU20x.

The name of the protocol file is broken up into three sections, the protocol, the main software revision and the terminal type that protocol file is for.

<table>
<thead>
<tr>
<th>Protocol Name</th>
<th>Software Revision</th>
<th>Terminal Type</th>
</tr>
</thead>
</table>

Example

snp_R4.1xx
This is the protocol file for release 4 software for the GE FANUC PLC, for the CTIU10X
df1_R4.2xx
This is the protocol file for release 4 software for Allen Bradley PLC, for the CTIU20X

To Update Protocol File
1. Set Terminal Type
2. Set the required Automation Equipment in Communications Settings
3. Select **Update TIU Protocol** from the **File** menu.
4. Select the folder of the terminal you have connected to the PC. The correct file will appear for the terminal type selected and the Automation Equipment selected. Select that file and click OK.

5. A status bar appears indicating download progress.

6. After the transfer, the CTIU050/10X/11X/20X resets itself. The correct PLC type is displayed on the CTIU050/10X/11X/20X.

7. Next, the project loaded runs.

8.10. Updating the Operating System

1. Select **Update Operating System** from the **File** menu.

2. Choose the updated file with the “BIN” extension. Click **OK**.

3. A status bar appears indicating download progress.

4. During the download process, CTIU050/10X/11X/20X displays the message “**SYSTEM SHUTDOWN**”.

8.11. Printing

The CTSW232 software has printout capability. To print, select **Print** from the **File** menu or click on the **Print** icon. The system parameters (# of menu pages, # of alarm pages, # of status pages, PLC type, port settings, communication configuration, and PLC station number) and all of the pages are printed.

The printer set-up is selecting **Printer Setup** from the **File** menu. The printer set-up screen is shown in Figure 8.3.

![Figure 8.3 – Printer Set-up Box](image)

8.12. To Insert a New Page

1. Click on the Insert Page Icon or from **Edit** choose **Insert Page**.

2. Pages can either be **Insert After Current Page** or **Insert Before Current Page**. Also, select the number of pages to be inserted. Click **OK**.

![Figure 8.4 – Insert Pages Message](image)
3. If the user goes to the last page of the project and clicks on the down key the a messages appears saying “There are no more pages in this menu, do you want to create some?” If the OK button is pressed the above insert menu pages appears.

Default Page Type
(CTIU20X Only)
With the CTIU20X series there are two types of pages.
a. Text Page
b. Graphic Page

The CTIU Software maybe set-up create either type of page by default or alternatively the software can be set up to display a warning message asking which type page is to be created every time a page or pages is inserted. (Prompt On Page Creation).

Text Page
A text page in the CTIU20X is similar to the normal page created with the CTIU10X/11X, i.e. the same functions that are available on the CTIU10X/11X are also available on a Text Page of the CTIU20X. To avail of the extra graphic features of the CTIU20X a Graphic page must be created.

Graphic Page
On a page maybe used to display all the features of the Text Page plus the extra features available for a Graphic Page. See chapter on Graphic Editor for further details of features available.

8.13. Download/Upload Character Set (Not available with the CTIU050)

After new characters have been created with the character generator, these characters must be downloaded to the TIU. Conversely, an existing character set in the TIU can be uploaded.

8.13.1 To Download a Character Set:

1. Select Download Character Set to Tiu from the File menu. A status bar appears; indicating the download is in progress.

   Note: If the message “Link Failed” appears, check the cables connecting the PC to the unit.

2. After the project has been downloaded, the message “Transfer Complete” appears. The new character set is now loaded to the TIU.

8.13.2 To Upload a Character set from the TIU:

1. Select Upload Character Set from the File menu.
2. A status bar appears; indicating the upload is in progress.
3. After the project has been uploaded, the message “Transfer Complete” appears.

8.14. Select Terminal Type

This software package supports the project of multiple Operator Stations (TIUs).

8.14.1 To select the Operator Station being used:

1. From Configure, pick Select Terminal Type and choose the model.
2. Choose the model or TIU being used. The screen changes to show the model just selected.
8.15. Delete a Page

1. Go to the page to be deleted. Click on the Delete Page icon or from **Edit** choose **Delete Page**.
2. The current page is deleted and the next page is displayed.

8.16. Font Size (Not available with the CTIU050)

There are four different Font Sizes: Normal, Double Height, Double Size (x2) and Four Times Size (x4). The size of an entire line is set, individual words on a line cannot have a different size then other words.

8.16.1 To change/set the Font Size of a line:

1. Click somewhere on the line to be adjusted.
2. Click on the desired **Font** icon. The size of the entire line is adjusted. Any characters beyond the right border of the screen are maintained but not displayed in the **CTIU** software or on the TIU.

8.17. Key Mapping

The keyboard can be mapped to PLC automation equipment along with the currently displayed page number. This enables keys to be used in Jog/Instantaneous action modes. Sending the page number allows the automation equipment to qualify the key states sent to ensure that the function only operates on the correct page. The page number is written to the specified data register, **Page Mapping**, and the keys are mapped into the next contiguous data register, **Key Mapping**.

8.17.1 To enable key mapping:

1. From the **Configure** menu, select **Keyboard Mapping**.
2. Check the **Enable** box.
3. Choose the **Register Type** and the **Map Page To Register**. Click **OK**.

The **Configure Key Mapping** screen displays the data type, the active page number (from which the keys are active) and the keyboard mapping bits. For example, page 3 is intended to cause a jog forward when up key is pressed, jog back when down key is pressed, and home when the enter key is pressed.

![Configure Keyboard Mapping Box](image)
8.18. Function Keys

8.18.1 General

The CTIU050/10X/11X/20X support function keys to be assigned in the project. The Up, Down, Pause and Enter key can be configured as function keys however are defined on a per page basis. Due to the fact that the keys may have other functions allocated to them the following restrictions are placed on the allocation of functions to these keys:

1. The Pause key is available for mapping on status pages, alarm pages, and menu pages with no editable embedded data, and which are not part of a submenu, and which do not have a submenu.
2. The Enter key is available for mapping on status pages, alarm pages and menu pages, except the first menu page.
3. The Down Key is available for mapping on status pages and on the last page of a submenu.
4. The Up Key is available for mapping on status pages and on the first page of a sub menu. (It is used for scrolling purposes on menu pages that are not the first in a submenu, and on alarm pages.)

Along with the Up, Down, Pause and Enter keys, the alphanumeric keypad on the CTIU050/11X/20X can also be assigned functions in the CTIU software. These function keys can be programmed on all page types and menus.

The Configure Function Key Screen lists the available function keys on each page. See Figure 8.6.

Double Click on the key to be programmed. Each key maybe programmed as a Global or Local function key. Programmed as a Local function, the key will only complete the function in the present page only. Programmed as a Global function, the key will perform the function on every page of the project.

![Configure Function Keys](image-url)
Note: The **Up**, **Down**, **Pause** and **Enter** keys can only be programmed as **Local** Function Keys.

The **Key Actions** for both **Local** and **Global** are:

1. **Disabled**
2. **Push Button**
3. **Preset Register**
4. **Display Page**
5. **Ramp Register**
6. **Set Bit**
7. **Clear Bit**
8. **Invert Bit**
9. **Execute Maths**

### Figure 8.7 Function Key Definition

1. **Disabled**
   Default setting, change to any other of the setting to enable function key.

2. **Push Button**
   Sets the register chosen in the **Location** and **Set Data type** to the value in the **Value** field while the button is pressed. The register is reset when the button is released.

3. **Preset Register.**
   Sets the register chosen in the **Location** and **Set Data type** to the value in the **Value** field.

4. **Display Page**
   Displays the specified page in the **Page Number** field.

5. **Ramp Register**
   Increases the value of the **Data Type** or register type specified under the **Location** field by the value entered in the **Value** field.

6. **Set Bit**
   Sets the bit specified in the **Bit** field of the **Location**, of the **Data Type** or register type to “1”.
7. **Clear Bit**  
Sets the bit specified in the **Bit** field of the **Location**, of the **Data Type** or register type to “0”.

8. **Invert Bit**  
Toggles the bit specified in the **Bit** field of the **Location**, of the **Data Type** or register type.

9. **Execute Maths**  
Executes mathematic function beginning at the specified line number.
9. EMBEDDED DATA

9.1. General

On the CTIU050/10X/11X up to 8 embedded data fields may be placed on each page. On the CTIU20X up to 64 embedded data fields may be placed on each page. Embedded data types are numeric (monitor or editable), alphanumeric (monitor only on the CTIU10X, editable on all other models), timer (monitor or editable), bit status (monitor or editable), system variable (monitor only), password (entry only in operation), Horizontal Fill, Text Selector, Recipe item, and Clock Calendar. Many of the sections in this chapter contain specific instructions that are intended to serve as examples only.

Note: If range checking is enabled, then increments and decrements are only allowed between the maximum and minimum ranges.

There are 4 ways to embed data onto the screen.

a. Double click the Display window area.
b. Click the Embed Data icon

c. Choose Edit/Embedded data from the menu.
d. Press Shift and Enter Keys together.

If you double click the display window area or click the Embed Data icon the following screen appears (Fig 9.1). From this the programmer can pick which type of data they wish to embed.

![Figure 9.1 – Chose Embedded Data Type](image-url)
9.2. Numeric Data

From the Embedded data list select **Numeric Data**, the screen shown in Figure 9.2 appears.

![Configure Numeric Embedded Data](image)

**Figure 9.2 – Numeric Data Type Box**

1. Select a **Data Type** (register or other) and enter a number for the **Location** (100 for example).

**Note:** For numbers 0-65535, use **16 Bit Unsigned** format. For numbers 0-999999999, use **32-Bit Unsigned** format. When 32-bit is selected two contiguous registers are read from the automation equipment. The first register read contains the low word and the second register contains the high word. The data source register specifies the first of two registers.

2. If **16 Bit** and **Signed** is chosen from Format, then numbers -32768 TO 32767 may be utilised.

3. The signed, 32-Bit format for numbers -999999999 to 999999999 may be selected by clicking on **32-Bit** and **Signed**.
9.2.1 To edit numeric data:

1. Check the Edit\Write box.
2. To enable range checking, check the Range Checking box and enter a Maximum and Minimum range number (100 and 5 for example).

9.2.2 To change data registers contents from the CTIU050/10X/11X/20X:

1. Press the Pause key to select the data field for editing. The selected field becomes highlighted.
2. To increment the data, press the Up key.
3. To decrement the data, press the Down key.
4. On Terminals CTIU050/11X/20X the numeric pad may be used as an easier way to enter data.
5. To enter the data to the PLC, press the Enter key. If range checking is active, then increment and decrement are only allowed between the maximum and minimum ranges.

9.3. Alphanumeric Data

9.3.1 General
From the Embedded data list select Alphanumeric Data, the screen shown in Figure 9.3 appears.

![Configure Alphanumeric Embedded Data](image)

Figure 9.3 – Alphanumeric Data
9.3.2 **To embed alphanumeric data:**

1. Select **Data Type**. Enter a number for the **Location** (100 for example).
2. Enter the **Number Of Characters** to be displayed. One character is a byte (8 bits). To have 10 characters, five registers are read.

9.4. **Timers**

9.4.1 **General**

From the Embedded data list select **Timers**, the screen shown in Figure 9.4 appears.

![Figure 9.4 – Timers](image-url)
9.4.2 To monitor Timers on the CTIU050/10X/11X/20X.

1. Select a Data Type, and enter Location number.
2. Select a timer format under Format. Table 6.1 shows the available timer format. A 32-bit timer reads two contiguous registers.
3. Check the Edit Enable box to allow for the editing of the time format.
4. Check the Range Checking box to enter a Maximum and Minimum range.
5. Range checking can be entered in SECONDS; MINUTES, SECONDS; or HOURS, MINUTES, SECONDS.

9.4.3 To edit the data field:

1. While displaying the appropriate page, press the Pause key to select the data field for editing. The selected field becomes highlighted.
2. To increment the data, press the Up key.
3. To decrement the data, press the Down key.
4. To enter the day to the PLC, press the Enter key. If range checking is active, then increment and decrement are only allowed between the maximum and minimum ranges.

<table>
<thead>
<tr>
<th>Table 9.1 – Configurations for Timer Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>16-Bit MM:SS</td>
</tr>
<tr>
<td>16-Bit HH:MM:SS</td>
</tr>
<tr>
<td>16-Bit MM:SS_T</td>
</tr>
<tr>
<td>16-Bit HH:MM:SS_T</td>
</tr>
<tr>
<td>16-Bit HH:MM</td>
</tr>
<tr>
<td>32-Bit MM:SS</td>
</tr>
<tr>
<td>32-Bit HH:MM:SS</td>
</tr>
<tr>
<td>32-Bit MM:SS_T</td>
</tr>
<tr>
<td>32-Bit HH:MM:SS_T</td>
</tr>
<tr>
<td>32-Bit HH:MM</td>
</tr>
<tr>
<td>* up to a maximum of 1:49:13.5</td>
</tr>
</tbody>
</table>

9.5. Bit Status

9.5.1 General

This section describes the bit status functions available in the CTIU050/10X/11X/20X. Use the instructions as follows to embed Bit Status.

1. From the Embedded data list select Bit Status
2. Select the Data Type (%I for example). Select Token Pair (“OFF”/“ON” for example).
3. Enter a number for the Location (register or other, 10 for example).
4. If a word Data Type is chosen, enter a Bit Number in the range of 0-15 under Format. If bit 0 is off, then “OFF” is displayed. If bit 0 is on, then “ON” is displayed.
5. To modify a token pair, select the token pair to be modified.
6. Click Edit Tokens.
7. Enter the “ON” and “OFF” descriptions (up to 10 characters) in the Enter Bit On Token and Enter Bit Off Token boxes.
8. After being modified, the modified token pair can now be selected as normal.
9.5.2 To select the data field for editing:

1. From the appropriate page, press the **Pause** key. The selected field becomes highlighted.
2. To turn the bit off or on, press the **Down** key or the **Up** key and press "**Enter**" to send the data to the PLC.

![Configure Bit Status Embedded Data](image)

**Figure 9.5 – Configure Bit Status**
9.6. System Variables

There are six different types of system variables. To embed system variables:

1. From the embedded data list select System Variable.
2. Select a system variable type under Select System Variable in the Format section.
3. Click OK.

![Figure 9.6 – Configure System Variable](image)

9.7. Passwords

9.7.1 To password protect a sub-menu:

1. From the embedded data list select Password. A series of question marks appear on the screen. Click OK.
2. Select Create SubMenu from the Edit menu. Enter the number of pages, you then have the option of password protecting the submenu.
3. There are two types of security access on sub-menus.
   - Simply one password to enter the sub-menu
   - Authority Level Mode

![Figure 9.7 – Configure Password](image)
The Authority Level Mode allows the programmer to give security levels to each sub-menu. Click Authority Level Mode and then enter the Authority Level to that sub-menu. Each Level can be given an individual password.

![Create SubMenu](image)

**Figure 9.8 – Configure Password Authority Mode**

9.7.2 **To enter the password from the CTIU050/10X/11X/20X:**

1. In the appropriate page, press the Pause key. The selected field becomes highlighted.
2. Enter the password by incrementing or decrementing the data field, by pressing the Up or Down key respectively.
3. Press the Enter and Up keys simultaneously.
4. The data must be equal to the pass code in order to enter into the sub-menu.
9.8. **Analog Meters**

An area of the display can be horizontally filled to create an analogue meter or gauge. The height of the block is fixed at the height of the current text line. To create a horizontal fill:

1. From the embedded data list select **Analog Meters**. Select the **Data Type** and **Location** under **Data Source**.
2. Type the **Number of Characters** under **Format**. The maximum width of the block is determined by the width of the page and the character size.
3. Select the **Maximum** and **Minimum** range. Minimum and maximum values define empty and full scale, respectively.

![Configure Analog Meters](image)

**Figure 9.9 – Configure Analog Meters**

**Note:** Only 16-bit registers may be read from the PLC. Only linear scaling is supported.
9.9. **Text Selector**

Text Tables are available in the CTIU050/10X/11X/20X **CTIU** software. There are 250 available text tables for use and they may be numbered from 1 to 250. Each text table may have up to 256 entries (numbered 0 to 255). Entries within each table may be called up by using the selected PLC register. When the ID of the entry is called up in the PLC register, the text string (entry) is displayed. The text strings are automatically forced to the width of the longest text string in the table (selected table). Strings are automatically left justified. Text tables are typically used in situations where the operator desires a visual message when some event (such as a value change in a register) occurs.

**Example:** A PLC is controlling a process that manufactures one of four drink types: Cola, Lemonade, Orange Juice, and Apple Juice.

The PLC has a register that contains the value of “6” when Cola is being made, “8” when lemonade is being made, “12” when Orange Juice is being made and “24” when Apple Juice is being made. A Text table can be created with four entries, 6, 8, 12 and 24, with the text for these items being the four products. Now, the PLC register can be monitored and the appropriate text inserted into a page on the CTIU050/100/110.

A maximum of 64kBytes can be used by all of the text tables.

9.9.1 **Edit Text Tables**

Text tables can be edited from the CTIU050/100/110. To choose the Text Selector function:

1. Select **Text Selector** embedded data list.
2. Select a **Data Type** and choose a number for the **Location**. The value in the Location (register or other) determines the text string (entry) number displayed (see 6.11).
3. Select a text **Table ID** number (1-250).

![Figure 9.10 – Configure Embedded Data](image)
4. If you want the ability to edit the text string from the CTIU050/10X/11X/20X, click the **Edit Enable** box.
5. To create/edit/delete entries, click the **Edit Table** button.
6. A Text Table box appears and the user has the ability to **Add**, **Delete**, and **Edit** text strings.

To Add an Table Entry

1. Click Add Figure 9.11 is displayed.
2. The field ID is automatically the next the available number in the table. This can be changed by typing in the number required or incremented using the up and down buttons to the right of the field.
3. In the text field enter the text corresponding to that field ID.
4. The size of the font which the text will be displayed can then be set to the character set sizes 6 x 8 or 12 x 16.
5. The programmer can enter the customised character generator by clicking edit font, see Chapter on Character Generator for further details.

![Figure 9.11 – Text Table Field Entry](image)

Text tables can be called in 3 different modes, **Decimal**, **Binary** and **Hexadecimal**. This refers to the format of the data in the register calling the text table. Also in Binary mode multiple text table entries can be displayed the user can then scroll between these text table entries, or set the Auto Scroll option to let the TIU to automatically scroll between all the selected entries.

![Figure 9.12 – Edit Text Table Entries](image)

9.9.2 To edit a text table from the CTIU050/10X/11X/20X:
1. Select the text string field by pressing the Pause key.
2. Move up or down the list using the Up and Down keys.
3. Press the Enter key to select the desired text string.

9.9.3 To Export/Import a Text Table

a. Export
1. Click the Export button.
2. Enter the location of the file.
3. Enter the name the file the text table is to be exported to.

b. Import
1. Click the Import button.
2. Click on the file to be imported.

9.9.4 Default Text Table Entries

If an undefined value is entered into the text table entry field (i.e., a value that has not been assigned in any text table), then one of two different things happen.

a. If the user has assigned a value to the Default Entry in the Text Table box, then that entry number is displayed. This value is assigned by first checking the box next to Default Entry, then entering a number in the box below.
b. If the box is unchecked and a default entry has not been selected, then a series of asterisks (corresponding to the longest entry in the text table) are displayed.

Example: There are four entries in the text table. These four entries have numbers of 23, 24, 54 and 67. The text in these entries is as follows:

23 - Cola
24 - Soda Water
54 - Apple Juice
67 - Orange Juice
100 Undefined

If an undefined value is entered (e.g. 97) then “************” is shown. If a default entry has been selected, i.e., 100 (any number can be used), then the text corresponding to 100, “Undefined” is displayed.
9.10. Clock Calendar

If the CTIU050/100/110 has been fitted with the real-time clock feature, then the time and/or date can be embedded as data. To embed the time and/or date:

1. Select Clock Calendar under embedded data list.

![Figure 9.13 – Text Table 1]

![Figure 9.14 – Configure Clock Calendar]
2. Choose the Format of the time and/or date to be displayed on the CTIU050/10X/11X/20X. Click OK.

9.10.1 Clock Calendar Mapping

It is also possible to map the clock calendar (time and date) information to the automation equipment. To do this:

1. From Configure, choose Clock Calendar Mapping.
2. Click Enable. Select the Data Type (register or other) and first register (or other) for the Map Start. Click OK.
3. The mapping is displayed in the Map field (see Figure 6.13).

![Figure 9.15 – Configure Clock Calendar Mapping]

9.11. Menu Timeout

The Menu Timeout is a useful safety feature. This forces the CTIU050/100/110 back to the first (main) menu page after a set time period. For example, the CTIU050/100/110 is on an input menu page, after 30 seconds of no activity, the CTIU050/100/110 reverts back to the non-input (safety) main menu page. To set the timeout:

From the configuration menu, select Configure, then Menu Timeout. A timeout is set in ALL menu and sub-menu pages. Time-outs in each screen may be inhibited from the Edit menu. To disable the Timeout function, set the time to 0 seconds.

![Figure 9.16 – Set Menu Timeout Box]

9.12. Flashing Characters

The user may have flashing characters on any line and on any type of page in the project. There are two different ways that flashing characters are implemented.

a. In the embedded data screen, under Attributes check the box for Flashing.
b. The other way to create flashing characters is to use the “TAB” key when you are creating the project. Flashing is toggled by line using the “TAB” key (current line the cursor is on). In this case, the entire line flashes.

**Note:** Flashing can not be enabled or disabled conditionally.

### 9.13. Set the Real-time Clock

The Real-time Clock is not a standard feature on all TIUs. The Real-time Clock is set from the PC’s clock. To automatically set the Real-time Clock from the PC’s clock:
Connect the TIU to the PC.
From File, choose Set Clock. The PC's time is downloaded to the Unit


Embedded Fields can be Scaled to convert register values from the AE into real-world numbers.

#### 9.14.1 To enable Scaling:

1. From the Embedded Data screen, click **Enable** in the **Scaling** box.
2. Enter the **TIU Minimum**, **TIU Maximum**, **Remote Minimum** and **Remote Maximum**.
3. After configuring any other fields, click **OK**.

The **TIU Minimum** and **Maximum** refer to the minimum and maximum values to be displayed on the TIU. The **Remote Minimum** and **Maximum** refer to the minimum and maximum values produced by the AE.

**Example.** Scaling can be used to convert the drive speed in RPM to a conveyor’s speed in m/min. This scaling could then be taking the gearbox and all the other mechanical factors into account. The maximum speed of the drive may be 1450, but the actual maximum speed of the conveyor is 100 m/min. Therefore, the Scaling configuration is as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIU Minimum</td>
<td>0</td>
</tr>
<tr>
<td>TIU Maximum</td>
<td>100</td>
</tr>
<tr>
<td>Remote Minimum</td>
<td>0</td>
</tr>
<tr>
<td>Remote Maximum</td>
<td>1450</td>
</tr>
</tbody>
</table>
9.15. Page Wizard

The Page Wizard is a short cut for building pages to set or view the internal real-time clock or view communication statistics.

9.15.1 To use the Page Wizard:

1. Move to or insert a page that is to be built.
2. Click the Page Wizard icon or from Configure, choose Page Wizard.
3. Click on the Page Type to be built and chose the particular Parameters to be displayed on the TIU. Click Build Page.

9.16. Graphing (Not available with the CTIU050)

This features graphs up to two plots of 21 contiguous registers. Plot 1 is the lower byte of the register and plot 2 is the upper byte of the register. The graph is updated continuously. The actual update time depends on the equipment connected to the TIU, and communication speed. The data structure is as follows:

```
Offset +0  Offset +1  Offset +2  . . .  Offset +21
Points    Data 1     Data 2     . . .     Data 21
```

**Points**
- HIGH Byte = Number of point for plot 2
- LOW Byte = Number of points for plot 1

Definitions:
- \(0\) = do not plot;
- \(1\) = plot first 11 registers on X-axis using 10 pixels per register;
- \(2\) = plot 21 registers on X-axis using 5 pixels per register;
- \(>2\) = assume 2.

**Data**
- HIGH Byte = Data for plot 2, plotted with a dotted line
- LOW Byte = Data for plot 1, plotted with a solid line

The scale of the Y-axis is 0 to 29. Values greater than 29 or negative values are plotted full scale.
9.16.1 To Embed a Graph:

1. Select Embedded Data from the Edit menu
2. Select Graph under Type.
3. Select a Data Type (register or other) and a Location (this is the First Data register, ).
4. Enter the number of points on the Graph, the number of points equals the number of data registers required.
5. Click OK.

9.16.2 Enable Axes

When this option is selected the X and Y-axes of the Graph is displayed on the CTIU11X/CTIU20X when the project is downloaded.

Note: The graph uses up 3/4 of a menu or submenu page and as such overwrites whatever data is on that page.

Figure 9.18 Embedding A Graph
9.17. **Trending (Not available with the CTIU050)**

This feature continuously plots up to two registers (channels) versus time. The maximum update rate depends on the equipment connected to the TIU, and communication speed.

### 9.17.1 Enable Axes

When this option is selected the X and Y-axes of the Trend are when the project is downloaded.

### 9.17.2 Data Indirectly Specified.

This option allows the programmer to indirectly specify the register which contains the data for the trend, i.e. the contents of the register, which is specified in the Location section of the Remote Data Source, specifies the register that contains the data for the trend.

### 9.17.3 Control Data from Remote Device

This option allows the programmer to control the set-up of the trend from registers stored in the automation equipment. The structure for setting up the trend is described further in this paragraph.

The data structure is as follows:

<table>
<thead>
<tr>
<th>Offset +0</th>
<th>Offset +1</th>
<th>Offset +2</th>
<th>Offset +3</th>
<th>Offset +4</th>
<th>Offset +5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Base</td>
<td>Ch. 1 Scale</td>
<td>Ch. 1 Data</td>
<td>Ch. 2 Scale</td>
<td>Ch. 2 Data</td>
<td>Width</td>
</tr>
</tbody>
</table>

![Figure 9.19 Embedding A Trend](image-url)
Time Base
0 = maximum update rate;
1 = 1/10s per plot
X = X/10s per plot, up to X=10

Scale
Maximum value of Y-axis for that channel; if 0 channel is not plotted.

Data
Raw register values. Negative values are plotted at full scale.

Width
Number of samples across the display
100 = 1 pixel per plot
50 = 2 pixels per plot
25 = 4 pixels per plot
10 = 10 pixels per plot
Any other value, the nearest to the above 4 is used.

If the Control Data from Remote Device option is not clicked then the trend is set-up as follows.

The Time Base is set by the Trend Width.
The scale is set by the Minimum and Maximum Range
The data for the first trace is taken from the register specified or indirectly specified in the
Location field
The data for the second trace is taken from the following register specified or indirectly specified
in the Location field.

Note: When Control Data from Remote Device is selected, the data to set-up the structure of the trend is
only read once, when you first go onto a screen where the trend is embedded. The data for the trend is
read continuously.

9.17.4 To Embed a Trend

1. Select Embedded Data from the Edit menu
2. Select Trend under Type.
3. Select a Data Type (register or other) and a Location.
4. To display axes with the graph, click the Enable Axes under Format.
5. Click OK.

Note: The trend uses up 3/4 of a menu or submenu page and as such overwrites whatever data is on that
page.
10. CHARACTER GENERATOR

10.1. General (Not available on the CTIU050)

The **CTIU** software allows the user to edit, create and display on the CTIU10X/11X/20X special characters. These characters may be company logos, special symbols or multilingual, non-standard KEYBOARD characters such as Ω, é, °, © or ±.

**Note:** The character set for the font double height is scaled automatically from the 8x6-character set. The character set for the font x4 is scaled automatically from the 16x12-character set.

Within each character set are up to 256 characters, however, not all these characters are usable and/or editable by the user.

<table>
<thead>
<tr>
<th>Characters 0 to 31</th>
<th>System characters – not useable or editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters 32 to 127</td>
<td>Standard keyboard characters – useable and editable although it is not recommended the user edit these characters.</td>
</tr>
<tr>
<td>Characters 128 to 160</td>
<td>Editable and useable characters. This is the area of the character set for use.</td>
</tr>
<tr>
<td>Characters 161 to 255</td>
<td>Extended keyboard characters – useable and editable although it is not recommended the user edit these characters.</td>
</tr>
</tbody>
</table>

10.2. To Insert a Special Character:

1. Place the pointer on the display where the character is to go.
2. Press `<Ctrl> <Enter>` or by clicking right mouse button. Click on the character in the Character Map (see Figure 10.2) to be inserted.
10.3. **To Create Or Edit a Character:**

1. From **Configure** on the menu bar, choose **Fonts**. The screen in Figure 10.1 appears.

2. Under **Character Set**, choose the **Character Size** to be edited. Beside **Set Name**, enter a name that describes this set.

3. Click on **Map** to show the total character set. The screen in Figure 7.2 appears. The first four rows are the standard keyboard characters, which should not normally be edited. The fifth row is editable and useable. The lower three rows are the extended keyboard characters, which may also be edited if you do not need the characters. Click on the character to be edited or blank box to create a character.

   ![Figure 10.1 - Character Generator](image)

   Click on a square to toggle that square on or off or drag and draw white of black lines.

   ![Figure 10.2 – Character Map](image)

   **NOTE:** Standard and Extended keyboard character are editable; however, this must be done with caution as it effects how characters are displayed on the CTIU050/100/110, i.e., changing “4” to • causes all 4’s from the drive to be displayed as •. 454 is displayed as •5•.
4. Under the **Character Bitmap** (see Figure 7.1), click on a square (pixel) to toggle that square on or off. The grey area is the space between characters and these squares should not be turned on.
5. Go to step 3 to edit the next character.
6. Once all the characters have been created or edited, click **Save File**. Choosing **Yes** over-writes the current character file. Choosing **No** gives the option to save this character set under a new file name.

**Note:** It is possible to double the size of an 8x6-character set. To do this click on the **Double** button. It is not possible to half the size of a 12x16-character set. It is recommended that the 8x6-character set be created first and then doubled.

### 10.4. International Keyboards

The **CTIU** software supports various international keyboard layouts. However, if the standard or extended keyboard characters are edited or deleted, the pressed key may appear different or not at all. The following keyboard layouts are supported:

<table>
<thead>
<tr>
<th>Table 10.2 – Supported Keyboard Layouts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Danish</td>
</tr>
<tr>
<td>Dutch (Belgium)</td>
</tr>
<tr>
<td>Dutch (Standard)</td>
</tr>
<tr>
<td>English (All)</td>
</tr>
<tr>
<td>Finnish</td>
</tr>
<tr>
<td>French (Standard)</td>
</tr>
</tbody>
</table>
11. RECIPES

11.1. General

Recipes allow the user to send or update multiple registers simultaneously. For example, it may be desired to run a vector motor at two different settings for two different applications.

   a. Speed of 1000rpm, max torque 50%, acceleration rate of 100s 0 - max speed and deceleration rate of 200s 0-max speed;
   b. Speed of 500rpm max torque 40.0%, acceleration rate of 500s 0- max speed and deceleration rate of 150s max speed.

Recipes enable the user to download all the fields (four in this example) at the same time without editing each individual field.

11.2. To Enable Recipes:

1. From Configure, select Recipes. Enter the Recipe Name, Number of Records in the Database and Number of Fields in Record. The number of Records and Fields can be changed later. Click OK.

2. The TIU Recipe Database Editor appears. Set the number of Records (different settings) and Fields (parameters).

3. Edit the Fields and Records as desired.

4. From File, select Exit to leave the Recipe Editor.

11.3. To Edit Recipe Fields and Records:

1. Open the Recipe Editor by clicking on the Recipe icon on the Toolbar or from Configure/Recipes.

2. Left click on the Field to be edited. Enter the Ingredient Name, Type Remote Data Source (register) and Format in the same manor as Embedded Data. Enable Scaling if desired.

3. Left click on the Record to be edited. Enter the value and click OK or press <Enter>.

4. From File, select Exit to leave the Recipe Editor.
11.4. To Rename a Record

1. Double click on the record name

```
+----------------+----------------+
| Enter Record   |               |
+----------------+----------------+
|                |               |
| Enter Value    | Record Name   |
|                |                |
| OK             | Cancel         |
+----------------+----------------+
```

![Record Name](Figure 11.2)

2. Type in the new record name
3. Click OK.

11.5. To Embed a Recipe Item on a Menu Page:

1. Select Embedded Data from the Edit menu.

```
+----------------+----------------+
| Configure Data |               |
+----------------+----------------+
| Remote Data    | Internally Generated |
| Data Source    |                |
+----------------+----------------+
| Display Format |               |
|                | Recipe Selector Field Recipe Name  |
|                | Recipe Field Tag |
|                | Recipe Field Contents |
+----------------+----------------+
| Ed/Write       |                 |
|                | Enabled         |
+----------------+----------------+
| Attributes     |                 |
|                | Flashing        |
+----------------+----------------+
```

![Embed Recipe Item](Figure 11.3)

2. Select **Recipe Item**.
   - **Recipe Selector**
     - Recipe Name will allow the user to edit the contents of each Item of the displayed Record; the Record name will be displayed.
     - If one of the items is selected then the user can edit the contents of each Item of the displayed Record; the Record number will be displayed.
   - **Recipe Field Tag**
     - If this is embedded on the menu page then the Item Name of the record selected for that menu page will be displayed.
   - **Recipe Field Contents**
     - If this is embedded on the menu page then the contents of the current Item, of the record selected for that menu page, will be displayed.
4. Click **OK**.

**Note:** A recipe item can be manually embedded on a menu page however for best results when embedding a recipe item on a screen see the Page Menu Wizard for Recipe Items. This can always be edited afterwards.

### 11.6. Importing and Exporting Data from a Recipe:

Recipe tables can be imported or exported. Files can be imported or exported as comma delimited (*.csv) or as print files (*.prn). Other file types may be viewed but may not load properly.

**Note:** Only *Records* are exported and imported, the *Field* names are not.

**Note:** If the table size that the data has been imported into is smaller then the table it was imported from, then not all of the data is displayed.

**Note:** Only one Record column can be selected per project at any time.
12. TUTORIAL

12.1. General

This chapter contains instructions for using several of the CTIU050/100/110 features. The projects in this chapter serve as examples and are not to be taken literally for all applications. After following this tutorial, the user should have a better understanding of how the CTIU050/100/110 operates.

12.2. Menus

The CTIU050/100/110 supports a total of 300 pages divided between menu and sub-menu, alarm and status pages. The following points are covered in this section:

1. Menus can have sub-menus.
2. Sub-menus can have sub-menus.
3. There may be up to 8 embedded data per page.
4. Embedded data can be displayed-type or entry/editing-type.
5. Sub-menus can be password protected.

Additional menu pages may be created by selecting Insert Page from the Edit menu or by selecting the “+” icon from the icon menu to the right of the Display screen. Selecting Delete Page from the Edit menu or by selecting the “-” icon will delete the displayed page.

The next menu page may be selected by clicking the “Down” key or by selecting the Next Page from the Goto menu. The previous menu page may be selected by clicking the “Up” key or by selecting Previous Page from the Goto menu.

Example: The CTIU050/100/110 is used to monitor the temperature of a furnace and indicate the heater or a fan is ON or OFF. This example uses a UD70 controller in a Unidrive, but is applicable to any PLC with modifications.

12.2.1 Steps involved in building configuration.

1. Select communication Settings from the Configure menu. Select the applicable automation equipment being used, in this example a Control Techniques Unidrive is used. Click OK. Update the Protocol if required.

2. Menu Page 1 shows some explanatory details about the program and should look like figure 12.1. For “Furnace Control #1” on line 3, click on the font double height icon at the beginning of the line.
3. Click on the Insert Page Icon. Choose **Insert After Current Page**. Click OK
4. Enter the text as shown in Figure 12.2.

5. Place the cursor one space to the right of “Temperature” and embed a **Numeric Data** in drive **PARAMETERS Location** 70.00. Select “XXX”, **16-Bit, Unsigned**. Click **OK**. Correct “C” position.

6. On the first space of the fourth line, click the embed icon. Choose **Analog Meter**, drive **PARAMETERS Location** 70.01. Under **Format**, enter 15 for characters, 760 for **Maximum** and 0 for **Minimum**. Click **OK**.

7. Place the cursor 6 space to the right of “Heater” and embed a **Bit Status** in drive **PARAMETERS Location** 70.02, bit number 0, **Select Token Pair** Format, “OFF”/“ON.” Click **OK**.

8. Place the cursor 9 spaces to the right of “Fan” and embed a **Bit Status** in drive **PARAMETERS Location** 70.02, bit number 1, **Select Token Pair** Format, “OFF”/“ONFF”, **Bit Number** 1. Click **OK**.
9. After embedding the data, the screen looks like Figure 12.3.

10. Under the **File** menu, click **Download Project**.

The temperature is displayed digitally and as a bar graph by the horizontal fill. Also, it is shown whether the heater and fan are ON or OFF.

**Note:** For this example to work, registers in the PLC area of the UD70 are used to simulate temperature, heater and fan.

### 12.3. Sub-Menus

Sub-menu pages branch off menu pages analogous to a sub-directory branching off a main directory of a PC. The CTIU050/100/110 supports a total of 300 pages divided between menu and sub-menu, alarm and status pages.

**Example:** Continuing from the example in Figure 12.2, one sub-menu is set up for the heater and one for the fan. Each sub-menu sets the temperature (within the furnace) at which the heater or fan turns ON/OFF.

**Note:** Ladder code needs to be written if this example is to work as anything more than an example.

1. Go to menu page 2. Under the **Create SubMenu** page, choose **2** for the **Number of Pages**. Be sure that the **Password Protect** box is unchecked. Click **OK**. The bottom middle cell should display **Menu Page 2.1** (indicating a sub-menu).
2. After completing this, enter the text as shown on the first sub-menu page (as follows):

![Image of CTU Configuration Package]

Figure 12.4 – Sub-Menu Page 2.1

3. Embed data one space to the right of “ON Temperature” by selecting Numeric for the Type, drive PARMETERS Location 70.03. Under Format, select “XXX”, 16-Bit Unsigned and click on Edit Enable. Click OK.

4. Do the same as in step 3 for “OFF Temperature” but use Location 11.

5. On the sixth line, one space to the right of “Manual Override” embed a Bit Status in drive PARMETERS Location 70.04, Select Token Pair Format, “OFF”/“ON”, Bit Number 1, Click on Edit Enable. Click OK.
6. Highlight the display screen, and select **Copy** from the **Edit** menu. Select **Next Page** from the **Goto** menu. Select **Paste** from the **Edit** Menu. Change the “Heater” to “Fan” and Fan ON and OFF temperature registers to 70.05 and 70.06, respectively. Change the **Bit Number** to 1 for the embedded data beside Manual Override.

7. Return to the parent menu by selecting **Parent Menu** from the **Goto** menu.

Under the **File** menu, you can **Save Project**, then **Download Project**.

The Screen appears as in Figure 12.5.

**12.3.1 To Enter A Sub-Menu On the CTIU050/10X/11X/20X:**

1. To go into a sub-menu from the main menu, press the **Pause** key and the **Down** key at the same time.
2. To edit the data, press the **Pause** key. Press the **Down** key to decrement the data, the **Up** key to increment the data and the **Enter** key to enter the data.
3. Press the **Pause** key and the **Up** key to return to the parent menu or the **Down** key to go to the next sub-menu page.
12.4. Password-Protected Sub-Menus

This tutorial section of the manual covers how to create password-protected sub-menus.

**Example:** Continuing from the example in 12.2, one sub-menu is set up for the heater and another for the fan. Each sub-menu sets the temperature (within the furnace) at which the heater or fan turns ON/OFF. This is the same as the example in 12.3 except that the sub-menus are now password protected.

1. Create a new menu page by selecting **Insert Page** from the **Edit** menu.
2. Enter the text, as shown in Figure 12.6.

![Image](https://via.placeholder.com/150)

**Figure 12.7 - Password Enter Screen**

3. Place the cursor one space to the right of “CODE” and select **Embedded Data** from the **Edit** menu. Select **Password** for the **Type**. Click OK. Four question marks should appear beside the word “CODE”.
4. Go to menu page 3. Select the **Modify SubMenu Properties**, and choose 2 for the **Number of Pages**. Check the **Password Protect** box, and enter a **Password** of “1234”. Click OK. The bottom middle cell should display Menu Page 3.1 (indicating a sub-menu).
5. Follow steps 2 through 8 in 9.3.
6. **Save** and **Download Project** to the CTIU050/100/110.
The resulting display screen on the CTIU050/100/110 appears as the screen shown in Figure 12.7 (with a code of 0000).

![Password Enter Screen](image)

**Figure 12.7 - Password Enter Screen**

12.4.1 *To Enter the Sub-Menu:*

1. Press the **Pause** key to edit the Pass Code.
2. Press the **Up** key to increment the code, 1234 in this example (hold the key down for speed incrementing), the **Down** key to decrement the data and the **Enter** key to enter the data.
3. Press the **Pause** key and the **Down** key at the same time to select the sub-menu page. The sub-menu page is only selected if the Pass Code is correct.

12.4.2 *To Edit The data On The Sub-Menu Pages:*

1. Press the **Pause** key to select the field to edit.
2. Press the **Up** key to toggle or increment the field. Press the **Down** key to decrement the field. Press the **Enter** key to send the value to the drive.
3. Press the **Pause** key to select the next field to edit.
4. Press the **Pause** key and the **Up** key at the same time to return to the parent menu.
12.5. Status

The CTIU050/10X/11X/20X can display STATUS information. For example, a status page can be displayed as COILS change (in real-time) in your drive, i.e., the first Coil displays the first Status page, the second coil the second page and so on.

Status messages can have up to eight embedded data values per page. Up to 300 total pages are available split between Status, Alarms and Menu pages.

Two different modes are available for configuring status pages. These modes are the Bit Mode and the Direct Mode.

- **Direct Mode** reads only one register as a word from the drive for the status page. If the value in this register is zero or greater than the number of configured status pages in the system, the main menu screen is displayed. Otherwise, the appropriate status screen is called up.

- **Bit Mode** works essentially the same, except that the screens are controlled by discrete bits instead of the full word register values.

**NOTE:** Status pages are only displayed when MENU PAGE 1 is selected.

**Example:** The following example involves the CTIU050/10X/11X/20X connected to Unidrive & UD70. It is applicable to any of the supported automation equipment with substitutions made for the specific registering nomenclature, i.e., 70.00 is a 32 bit multipurpose register which can be mapped to the Beckhoff remote I/O. It is assumed the drive is properly configured, the CTIU050/10X/11X/20X is properly connected to the drive, both are powered up, and the CTIU software, is running on the PC.

1. Select **Communication Settings** from the **Configure** menu. Select the automation equipment type you are using. For the example here, a “Control Techniques Unidrive protocol” is being used. Click **OK**.

2. Insert a menu page after Menu Page 1 (refer to 12.2 for instructions). Place the cursor at the left on the first line. Click the double height icon. Type “Discrete Outputs:”

3. On the third line, type “_R1%.0”. Click on the Embed Icon. Select **Bit Status** from Type; Drive parameter from Data Type; Location 72.01, bit number 0; leave Token Pair as “OFF”/”ON” and click Edit Enable. Click **OK**. See Figure 8.8.

4. Do the same for _R1%.1, _R1%.2 and _R1%.3 on lines 4, 5 and 6, incrementing the Bit Number by one. These discrete outputs will simulate coils. Menu Page 2(2) should be the same as Figure 12.9.
Figure 12.8 – Configure Embedded Data Box

Figure 12.9 – Menu Page 2(2)
From Configure, choose Status. Click Direct Mode. From Data Type choose drive parameter (72.01; Block Start equals 0. The Number of Status Pages equals 4. Click OK.

![Configure Status Pages](image)

**Figure 12.10 – Configure Status Pages**

From View, choose Status. This displays the first of four status pages. On the third line, delete what is there and type “Status Page:” on the fourth line, click on the x4 icon and type “1” in the centre of the line. Status Page 1 appears as the screen in Figure 12.11. Highlight display screen, click Edit and Copy.

![Configure Status](image)

**Figure 12.11 – Configure Status**
Click the down arrow icon on the project software to get to Status Page 2 of 4. Delete what is on the display screen, then from Edit, choose Paste Page. Change the “1” on line four to a “2.” Do the same for pages 3 and 4.

From File, choose Download Project

**Figure 12.12 – Status Page 0**

On the CTIU050/10X/11X/20X, press the DOWN key to get to the Discrete Output page (as in Figure 12.8). Press the PAUSE key the toggle bit 0: ON by pressing the UP key and ENTER key. Press the PAUSE key until nothing is highlighted (three times).

Press the UP key. The page shown in Figure 8.12 should be displayed.

| Note: Status pages are only displayed from Menu Page 1. |

5. Press the DOWN key and return to the Discrete Outputs page. Toggle bit 1:OFF and bit 3:ON. Return to Menu Page 1 by pressing the UP key. Now Status Page 4 is displayed. This is because Direct Mode is selected and the register is being read as a word, i.e., 0100 binary = 4.

6. Toggle bit 1: ON, bit 2: ON, bit 3: OFF and bit 4: OFF. Now Status screen 3 is displayed (0110B=3).

7. Toggle bit 4: ON and all the other OFF. Now a screen with “Default Menu Screen” written on the second line is displayed. The CTIU050/100/110 is looking for Status Page 8 (1000B = 8), which does not exist, so the default screen is displayed.

8. In the CTIU software, choose Status from Configure. Click on Bit Mode. Click OK. Download the project to the CTIU050/100/110.

9. Now Status Page 4 is displayed. In Bit Mode, the CTIU050/100/110 reads the register as discrete bits, not as a word, i.e., 1000 triggers Status Page 4, 0100 triggers Status Page 3, etc.
12.6 Alarms

12.6.1 General

The CTIU050/100/110 can display ALARM information as BITS change in your drive (real-time). The active alarms can be accepted and then SCROLLED through. Up to 300 total pages are available split between Alarms, Status and Menu pages.

The CTIU050/100/110 also has an Alarm Acknowledge Table. This feature allows a set of bits to be written back to the drive to indicate alarms that have been accepted by the user, but are still “ON” in the drive table. These bits are in the same format as the “incoming” alarm bits. The acknowledgement bits are set when an alarm has been acknowledged, provided that the corresponding bit is still active in the alarm table. The acknowledgement bit is cleared when the corresponding alarm bit is cleared. Click the **Enable** box to use the Alarm Acknowledge Table.

**Example**: The CTIU100 or 110 is connected to a Unidrive. Register _P20% AKA #70.20, bits 0 to 3 are the alarms. Register _P21% AKA #70.21, bits 0 to 3 are the acknowledgement table. The instructions below are a tutorial of how to use the Alarms on the CTIU050/100/110.

1. Select **Alarms** from the **Configure** menu.
2. Set the **Data Type** to drive parameters. Enter the location of the **Block Start** as 70.20.
3. Enter the number of alarm pages in the **Number Of Alarms** box (4 for example). If the number of alarms is greater than 16, then the next drive register is read.
4. Check the **Acknowledgement Table Enable** box. Set **Data Type** to drive parameters and **Block Start** to #70.21. Click **OK**.
5. Insert a page (Page 2) after Page 1. Go to page 2. On the second line type “Alarm:” and embed #70.20 beside. Make the embedded #70.20 field **Numeric**, two digits and **Edit Enabled** with a **Range Maximum** of 15. This field acts as the alarms.
6. On the fourth line, type “Acknwldg Table:” and embed #70.21 beside. Make the embedded #70.22 field **Numeric** and two digits. This field holds the Acknowledgement table.
7. Select **Alarms** from the **View** menu. The bar at the bottom displays the alarm page selected.

![Configure Alarms](image)

**Figure 12.13 – Alarm setup**
The next alarm page can be selected by clicking the **Down** key or by selecting **Next Page** from the **Goto** menu. The previous alarm page can be selected by clicking the **Up** key or by selecting **Previous Page** from the **Goto** menu.

8. Enter text in Figure 12.14.

![Figure 12.14 - Alarm Page 1 Screen](image)

9. Place the cursor beside either “ACCEPTED” OR “UNACCEPTED” and select **Embedded Data** from the **Edit** menu or click the embedded data icon (X.X).

10. Select **System Variable** under **Type** and **XXX Accepted Alarms** or **XXX Unaccepted Alarms** under **Select System Variable** in the **Format** section.

11. Block the entire page. From the **Edit** menu, select **Copy** (or type <Ctrl-C>).

12. Page down to Alarm Page 2 of 4 using **Next Page** from the **Goto** menu. Paste Page 1 to Page 2 using **Paste** from the **Edit** menu (or <Ctrl-V>). Do the same for alarm page 3 and 4.
13. **Download Project** to the CTIU050/100/110. Put your drive in “RUN” mode.

On the CTIU050/100/110:

**Scenario 1: energise alarm 1.** Go to page 2. Select the field beside “Alarm” by pressing the Pause key. Change the value to 1 and press the Enter key.

**Action:** Alarm Page 1 is displayed. The user presses Enter. The alarm page goes away and “Acknwldg Table:” (#70.21) equals 1 indicating alarm 1 has been acknowledged.

**Scenario 2: energise alarm 3.** One page 2, change the Alarm field to 0, press Enter. The “Acknwldg Table:” field returns to 0 as well. Set the “Alarm” field to 4 (the CTIU050/100/110 read discrete bits for the alarms, so 0100 binary, i.e., bit 3 high equals 4 decimal).

**Action:** Alarm Page 3 is displayed. The user presses Enter. The alarm page goes away and “Acknwldg Table:” (#70.21) equals 4 (i.e., bit 3 is high) indicating alarm 3 has been acknowledged.

**Scenario 3: energise alarms 1, 2 and 3.** One page 2, change the Alarm field to 0, press Enter. The “Acknwldg Table:” field returns to 0 as well. Set the “Alarm” field to 7 (the CTIU050/100/110 read discrete bits for the alarms, so 0111 binary equals 7 decimal).

**Action:**

a. Alarm pages 1, 2 and 3 are active. Alarm page 1 is displayed as the first alarm. Until any alarms are accepted, the Alarms Accepted reads 000 and the Alarms Unaccepted reads 003.

b. The next Active alarm page can be selected by pressing the Down key on the CTIU050/100/110. The last Active alarm can be selected by pressing the Up key on the CTIU050/100/110.

c. The Active Unaccepted Alarms can be accepted by pressing the Enter key on the CTIU050/100/110. Only one alarm is accepted at a time. Once an alarm is accepted, the next alarm is displayed. Accept all 3 alarms.

Go to page 1. Accepted Active Alarms can be recalled by pressing the Enter key. Accepted Active Alarms are scrolled through with the Up key and the Down keys on the CTIU050/100/110. Pressing the Enter key again returns display to page 1.

**Note:** Active Unaccepted alarms are displayed as a priority on any page.
13. GRAPHIC EDITOR

13.1. General

The TIU Graphic editor is designed to be a simple Drawing and Graphic Editor to be used with the CTIU20X. The CTIU20X can have 2 types of pages, a Text Page and a Graphic Page. The text page works similarly to the menu pages on the CTIU10X/11X. On Graphic pages, as well as all the features of the text page, also includes many other graphical features, such as; Shapes with 3 different backgrounds, bit maps and bit map animation.

All features are designed to be intuitive to the experienced user of Windows™ type applications. The following paragraphs describe most of the features available, however hopefully the user will find the software easy to use with some experimentation.

13.2. Draw Mode

Select a drawing mode by clicking on the appropriate button on the Shapes Toolbar, by choosing Setting/Draw Mode from the main menu. Before drawing the object choose the Background Fill (this maybe changed afterwards).

13.2.1 Selector

The selector tool may be used to select objects or groups of objects already created. Select an object by clicking on any part of the object. Set the properties of an object by double clicking on the object.

To select all objects click Edit/Select All.

13.2.2 Rectangle

1. Select Rectangle Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired rectangle. Click and hold the left mouse button.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Draw Mode returns to Selector as default
6. To edit the size of the rectangle click on the object, then click on one of the black dots around the object. Drag this dot around on the screen and the rectangle will change size automatically.

Figure 13.1 – The Shapes Toolbar
13.2.3 **Ellipse**

1. Select **Ellipse Draw Mode**.
2. Select the background and pen colour.
3. Move to a corner of the desired ellipse. Click and hold the left mouse button.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The **Draw Mode** returns to **Selector** as default.
6. To edit the size of the ellipse click on the object, then click on one of the black dots around the object. Drag this dot around on the screen and the ellipse will change size automatically.

13.2.4 **Rectangle with Round Corners**

1. Select **Rectangle with Rounded Corners Draw Mode**.
2. Select the background and pen colour.
3. Move to a corner of the desired rectangle. Click and hold the left mouse button.
4. The **Draw Mode** returns to **Selector** as default.
5. To edit the size of the ellipse click on the object, then click on one of the black dots around the object. Drag this dot around on the screen and the ellipse will change size automatically.

13.2.5 **Line**

1. Select **Line Draw Mode**.
2. Select the background and pen colour.
3. Move to a corner of the desired line. Click and hold the left mouse button.
4. Drag the mouse to where the second point is to be located.
5. The **Draw Mode** returns to **Selector** as default.
6. To edit the size of the line and shape click on the object, then click on one of the black dots around the object. Drag this dot around on the screen and the line will change size automatically.

13.2.6 **Arc**

1. Select **Arc Draw Mode**.
2. Select the background and pen colour.
3. Move to a corner of the desired arc. Click and hold the left mouse button.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The **Draw Mode** returns to **Selector** as default.
6. To edit the size of the arc and shape click on the object, then click on one of the black dots around the object. Drag this dot around on the screen and the arc will change size automatically.
13.2.7  **Text Mode**

1. Select **Text Mode**.
2. The background on text mode is by default transparent (This can be edited later).
3. Click on the screen, this will become the top left-hand corner of the text box.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Set Text window opens (Fig 13.2)

![Set Text](image)

**Figure 13.2 – Set Text**

6. In the text box type the text to appear on screen.
7. The **Alignment** and **Text Direction** can be set, along with **Invert Colours** and **Fill Background**
8. The text is displayed in the original text area drawn, in an appropriate size font.
9. The **Draw Mode** returns to **Selector** as default
10. To edit the size of the font click on the object, then click on one of the black dots around the object. Drag this dot around on the screen and the font will change size automatically.

13.2.8  **Static Bitmap**

1. Select **Static Bitmap Mode**.
2. Click on the screen, this will become the top left-hand corner of the bitmap area.
3. Drag the mouse to where the bottom right hand corner is to be located. This will also set the size of the bitmap.

**Note:** once created the bitmap size can not be changed directly. To change the bitmap size, the bitmap image needs to be exported to a file, a new bitmap created the required size and the old bitmap image imported back from the file of the original bitmap image.
The Static Bitmap Editor opens (Fig 13.3)

The tools available to draw shapes using the bitmap editor are very similar to the picture editor. The exceptions are as follows:

a. In Text mode only Transparent and Opaque are available for background fill. The font Size needs to set before beginning to type text, in Setting/Font.

b. A Flood Fill Tool is available. Click the flood fill tool button and then click in the area to be filled.

c. Zoom option. Click the zoom tool button then click on roughly the area to zoomed. A separate window appears displaying the zoomed area.

d. Left mouse button acts as draw black on green, Right mouse button acts as draw green on black.

Note: The bitmap can be dynamically resized.
13.2.9 **Table Mode**

This tool allows you to easily draw the lines for a table and enter a Table Header. Once the table is created the number of rows and columns can not be edited directly. Boxes or lines may be added manually afterwards.

1. Select **Table Mode**.
2. Click on the screen, this will become the top left hand corner of the Table.
3. Drag the mouse to where the bottom right hand corner is to be located. This sets the size of the table only.
4. The Table Creation windows open (Fig 13.4)

![Figure 13.4 – Table Creation](image)

5. Set the number of columns and rows you require.
6. Click on Add Table Header and enter Table Header Text if required.
7. The 3D effect adds an extra line on the right side of the table to give the effect of shadow.
8. Click OK to create table.
9. The table will then be drawn in the area specified at the beginning.
10. The **Draw Mode** returns to **Selector** as default.
13.3. **Embedding Data on a Graphic Menu Page**

### 13.3.1 **General**

The Embedded Data types are similar to the data types on text menu pages. All data types work the same as they do on a text page see Chapter on Embedded Data. The main difference is how the data type is embedded on the screen.

To Embeded Data on the Screen
1. Choose the Embedded Data type you wish to embed.
2. Click on the screen, this will become the top left hand corner of the area the displayed data will take up.
3. The normal embedded data type window will appear. Set-up the embedded dat type as required (See Chapter on Embedded Data).
4. Once the embedded data type is created it is displayed in the area defined earlier, in a font size appropriate to the size of the area.

### 13.3.2 **Analogue Meter**

Similar to the horizontal meter Control Techniques has added a “Needle Meter” type Analogue Meter. It is embedded on the menu page similar to the Horizontal Meter.

To Embeded an Analogue Meter on the Screen
1. Choose the Analogue Meter Data type.
2. Click on the screen, this will become the top left hand corner of the area the displayed data will take up.
3. The normal embedded data type window will appear. Set-up the embedded data type as required (See Chapter on Embedded Data).
4. Once the embedded data type is created it is displayed in the area defined earlier.
13.4. Animated Bit Map Selector

13.4.1 General
In a graphic page there is one extra embedded data type available, Animated Bitmap Selector.

13.4.2 To Embed a Animated Bitmap Selector
1. Choose the Animated Bitmap selector Embedded Data type.
2. Click on the screen, this will become the top left hand corner of the bitmap area.
3. Drag the mouse to where the bottom right hand corner is to be located.
4. The normal Animated Bitmap Selector data type window will appear (Fig 13.6).

Choose the **Data Type** and the **Location** of the control register of the bitmap selector.

5. Click on **NEW ANIMATED BITMAP**.
6. Click edit table and the size of the bitmap icon is displayed (Fig 13.7). The size of the bitmap icon can be changed now.

**Note:** Once created the bitmap size can not be changed directly. To change the bitmap size, the bitmap image needs to be exported to a file, a new bitmap created the required size and the old bitmap image imported back from the file of the original bitmap image.
7. Click OK to display the bitmap icon table.
8. A blank table will be displayed.
9. Click the **Add** button to display the Icon Editor (Fig 13.8).
10. Select a **Field ID** number (1-250).
11. Double click on the icon area in the centre of the screen. The Bitmap Editor opens the icon as a bitmap to be edited. The Icon is displayed with a checkered design as default. To **Clear** the bitmap choose **Image/Clear** from the main menu.
12. See Static Bitmap Editor for details on how to create graphic images in the bitmap icon.
13. Once the bitmap has been completed close the Bitmap Editor and the bitmap icon will appear in the Icon Editor.

![Figure 13.7 – Set Bitmap Icon Size](image)

![Figure 13.8 – Icon Editor](image)
13.4.3 To Edit a Bitmap table from the CTIU20X:

1. Select the text string field by pressing the **Pause** key.
2. Move up or down the list using the **Up** and **Down** keys.
3. Press the **Enter** key to select the desired text string.

13.4.4 To Export/Import a Bitmap Table

a. Export
1. Click the **Export** button.
2. Enter the location of the file.
3. Enter the name the file the text table is to be exported to.
b. Import
1. Click the **Import** button.
2. Click on the file to be imported.

### 13.4.5 Default Bitmap Table ID Entries

If an undefined value is entered into the Field ID table entry field (i.e., a value that has **not** been assigned in any bitmap table), then one of two different things happen.

1. If the user has assigned a value to the **Default Entry** in the Text Table box, then that entry number is displayed. This value is assigned by first checking the box next to **Default Entry**, then entering a number in the box below.
2. If the box is unchecked and a default entry has not been selected, then a blank bitmap is displayed.

### 13.4.6 Draw Attributes

The properties or **Attributes** of a shape can be set before or after the shape is drawn.

![Figure 13.9 Draw Attributes](image-url)
14. NETWORKING

14.1. General
There is now a networking option available with the CTIU101/111/201. These units support Device Net and CsCan network protocols. This chapter will discuss the registers used for network communication and how to configure the TIU units for network communication.

14.2. Network I/O
The CTIU101/111/201 units contain a special set of registers called Global Network I/O, or simply Global I/O. Using the CsCan protocol these bits are automatically sent through the network to all other units on the network. Anyone unit can be made aware of the activities of any other unit on the network, and any one unit can send a signal to any or all other unit on the network.

There are four (4) types of global registers available - %IG, %QG, %AIG, and %AQG. The model defines the type and number of global registers available in any given model.

The global ‘I’ registers contain an image of global ‘Q’ registers located in a different unit connected to the network. The association between I registers and ‘Q’ registers is set at the destination unit.

Any ‘I’ register may be associated to one and only one ‘Q’ register, but that ‘Q’ register may be located in any other unit on the network. Any ‘Q’ register is broadcast on the network for any or all other units to use.

<table>
<thead>
<tr>
<th>Type</th>
<th>Function</th>
<th>Retentive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%AIG</td>
<td>Network Analog Input</td>
<td>No</td>
<td>Specially defined analog inputs that come from the CsCan network protocol. Data is in words.</td>
</tr>
<tr>
<td>%AQG</td>
<td>Network Analog Output</td>
<td>No</td>
<td>Specially defined analog outputs that go to the CsCan network protocol. Data is in words.</td>
</tr>
<tr>
<td>%IG</td>
<td>Network Digital Input</td>
<td>No</td>
<td>Single bit registers that come from the CsCan network protocol.</td>
</tr>
<tr>
<td>%QG</td>
<td>Network Digital Output</td>
<td>No</td>
<td>Specially defined digital outputs that go to the CsCan network protocol.</td>
</tr>
</tbody>
</table>

14.3. Configuring the CTIU101/111/201 for Network Communication.

16. From the main screen of the CTIU software select Network from the drop down Configuration menu.

17. From the Configure Network screen select the node ID and the appropriate network protocol.
3. From this screen the network inputs and outputs are also defined. To configure a unit to read a single bit register from the network, select a specific %IG register from the list, by double clicking on the name of the register. As per Figure 14.2 enter the network ID of the data source and the specific register (%QG) from that network ID.

![Figure 14.1 - Network Configuration (Read)](image1)

![Figure 14.2 - Configure Network Input](image2)

4. The data read from the %QG register can be directly sent to a specific register automation equipment. From figure 14.2 enable the Data Destination box and define the automation equipment register that %QG1 is to be sent to.
5. To configure units to write a single bit register to the network select a specific \%QG register from the list as per Figure 14.3 by double clicking on the register name.

![Configure Network Window](image)

**Figure 14.3 - Configure Network (Write)**

6. From the **Configure Network Output** window (Figure 14.4) enable the **Data Source** box and define the automation equipment register that is to be outputted to the network. The **Scan Period** determines how often the network checks the value in the register for changes.
Similarly the CTIU101/111/201 units support the transfer of words over the network. This is done using the %AIG registers for inputs and the %AQG registers for outputs.

**Figure 14.4 – Configure Network Output**

7. Similarly the CTIU101/111/201 units support the transfer of words over the network. This is done using the %AIG registers for inputs and the %AQG registers for outputs.
15. MATHEMATICS

15.1. General
The CTIU10X/11X/20X now contains a Mathematic Interpreter. Up to 1024 lines of Mathematic Statements can be programmed into the terminal, and these can be split into function blocks which are called by the system as required. The function blocks are called on any of the following basis...

<table>
<thead>
<tr>
<th>Call Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Tasks</td>
<td>At regularly repeating intervals, definable down to 0.01 seconds</td>
</tr>
<tr>
<td>Scheduled Tasks</td>
<td>At a particular time (HH: MM) on specified days of the week</td>
</tr>
<tr>
<td>Function Key Presses</td>
<td>As function keys are pressed</td>
</tr>
<tr>
<td>Dialog Linkages</td>
<td>To initialise operator dialog sequences and also as keys are pressed in operator dialog sequences</td>
</tr>
<tr>
<td>One Shot Communications</td>
<td>On successful or failed one shot communications blocks</td>
</tr>
</tbody>
</table>

15.2. Internal & System Registers
The available internal registers are as follows: -

<table>
<thead>
<tr>
<th>Description</th>
<th>Name</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit Input</td>
<td>SmartStack %I</td>
<td>Only if SmartStack Configured</td>
</tr>
<tr>
<td>Bit Output</td>
<td>SmartStack %Q</td>
<td>Only if SmartStack Configured</td>
</tr>
<tr>
<td>Word Input</td>
<td>SmartStack %AI</td>
<td>Only if SmartStack Configured</td>
</tr>
<tr>
<td>Word Output</td>
<td>SmartStack %AQ</td>
<td>Only if SmartStack Configured</td>
</tr>
<tr>
<td>Internal Word Register</td>
<td>Internal %R</td>
<td>Only if Maths Configured</td>
</tr>
<tr>
<td>Internal System Register</td>
<td>Internal %SR</td>
<td>Only if Maths Configured</td>
</tr>
<tr>
<td>Internal Bit Register</td>
<td>Internal %M</td>
<td>Only if Maths Configured</td>
</tr>
<tr>
<td>Network Word Output</td>
<td>Network %AQ</td>
<td>Only if Network Configured</td>
</tr>
<tr>
<td>Network Word Input</td>
<td>Network %AI</td>
<td>Only if Network Configured</td>
</tr>
<tr>
<td>Network Bit Output</td>
<td>Network %Q</td>
<td>Only if Network Configured</td>
</tr>
<tr>
<td>Network Bit Input</td>
<td>Network %I</td>
<td>Only if Network Configured</td>
</tr>
</tbody>
</table>
The Internal System Registers available are as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Read / Write</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%SR01</td>
<td>R/W</td>
<td>Contains the current page ID</td>
</tr>
<tr>
<td>%SR02</td>
<td>R</td>
<td>Contains the state of the up/down/pause/enter keys.</td>
</tr>
<tr>
<td>%SR03</td>
<td>R/W</td>
<td>Contains the Global drive Network Address</td>
</tr>
<tr>
<td>%SR04</td>
<td>R/W</td>
<td>Contains the current password</td>
</tr>
<tr>
<td>%SR05</td>
<td>R/W</td>
<td>Contains the current edit status (V4.10n onwards)</td>
</tr>
<tr>
<td>%SR11</td>
<td>R</td>
<td>Contains the RTC seconds</td>
</tr>
<tr>
<td>%SR12</td>
<td>R</td>
<td>Contains the RTC minutes</td>
</tr>
<tr>
<td>%SR13</td>
<td>R</td>
<td>Contains the RTC hours</td>
</tr>
<tr>
<td>%SR14</td>
<td>R</td>
<td>Contains the RTC date</td>
</tr>
<tr>
<td>%SR15</td>
<td>R</td>
<td>Contains the RTC month</td>
</tr>
<tr>
<td>%SR16</td>
<td>R</td>
<td>Contains the RTC year</td>
</tr>
<tr>
<td>%SR17</td>
<td>R</td>
<td>Contains the RTC number of days in current month</td>
</tr>
<tr>
<td>%SR18</td>
<td>R</td>
<td>Contains the RTC number of the day in the year (eg. 1st February = 32)</td>
</tr>
<tr>
<td>%SR19</td>
<td>R</td>
<td>Contains the RTC day of week</td>
</tr>
<tr>
<td>%SR21</td>
<td>R</td>
<td>Contains number of accepted alarms</td>
</tr>
<tr>
<td>%SR22</td>
<td>R</td>
<td>Contains number of unaccepted alarms</td>
</tr>
<tr>
<td>%SR23</td>
<td>R/W</td>
<td>Contains the total number of attempts to the drive (Writing any values resets all comms counters)</td>
</tr>
<tr>
<td>%SR24</td>
<td>R/W</td>
<td>Contains number of good comms transactions</td>
</tr>
<tr>
<td>%SR25</td>
<td>R/W</td>
<td>Contains number of bad comms transactions</td>
</tr>
<tr>
<td>%SR26</td>
<td>R/W</td>
<td>Contains number of no comms transactions</td>
</tr>
</tbody>
</table>

15.3. Maths Functions
Maths functions may be used for a variety of purposes.
1. Maintaining Internal Variables
2. Controlling Database Operations
3. Generating Alarms

15.4. Execution of Maths Functions
Maths functions are called by starting at a specified line. The lines are processed consecutively beginning at the start line until a line with a “END” marker is processed, or the end of the maths listing is reached. Control may be switched using a GOTO statement in the function block or using any of the conditional statements, which will jump to another line or END marker.

15.5. Mathedit Windows Application
To view and modify the contents of the Mathedit Application, click the mathematics icon from the tool bar, or choose Maths from Configure in the main menu, the Mathedit Application window appears (Fig 15.1).
15.6. Opcodes

The available operational statements are:

1. No Operation
2. Conditional
3. Assignment
4. Bit Operation
5. Table Operation
6. Function
7. Control Flow
8. Set End

15.6.1 No Operation

This statement causes the line to do nothing. The statement shows as a blank line.

15.6.2 Conditional

This statement compares the contents of a local store register with either the contents of another local store register or a constant. After which an action is completed, depending on the result of the comparison.

The available Comparison Tests are:

1. Equal
2. Not Equal
3. Less Than
4. Less Than or Equal
5. Greater Than or Equal
6. Greater Than
7. And
8. Or

Conditional Action
If the result of the test is true than the chosen action is executed.

Note: The And and Or statements are true if the result equals not zero.

1. Set Bit
Sets the bit in the specified Local Store Bit Register.

2. Terminate Function
Terminates the function. An End statement is put at the end of the line statement.

Jump to specified line number or End

Figure 15.2 Conditional Action
15.6.3 Assignment

This statement assigns a value to the specified local register. The value of the register can be mathematically manipulated before storing it in the local register.

![Assignment Statement](image)

**Figure 15.3 – Assignment Statement**

The available mathematical functions are:

1. Equal
   - This function makes one Register equal another register.

2. Plus
   - This function lets the programmer add the contents of a register to the contents of another register or constant and stores the result in the specified register.

3. Minus
   - This function lets the programmer subtract the contents of a register or constant from the contents of a register and stores the result in the specified register.

4. Multiply
   - This function lets the programmer multiply the contents of a register by the contents of another register or constant and stores the result in the specified register.

5. Divide
   - This function lets the programmer divide the contents of a register by the contents of another register or constant and stores the result in the specified register.

6. Percentage
   - This function lets the programmer multiply the contents of a register by the contents of another register or constant and stores the result as a percentage of the first register in the specified register.

7. And
   - This function lets the programmer AND the contents of a register with the contents of another register or constant and stores the result in the specified register.
8. **Or**
This function lets the programmer OR the contents of a register with the contents of another register or constant and stores the result in the specified register.

9. **Exclusive Or**
This function lets the programmer XOR the contents of a register with the contents of another register or constant and stores the result in the specified register.

**Note:** Indirection is allowed on the %R local registers, e.g. %R10 = %R(%R40) + %R(%R41). If %R40 contain 100 and %R41 contains 11, then %R10 will be sum of the contents of %R100 and %R11.

15.6.4 **Bit Operation**

This operational statement can perform 4 different operations on a local bit register.

1. **Set**
   Changes the bit value to 1

2. **Clear**
   Changes the bit value to 0

3. **Invert**
   Changes the bit value to 1, if present value is 0, or changes the bit value to 0, if present value is 1.

4. **Pulse**
   Sets the specified bit high for 1 second and clears it to go low.

![Figure 15.4 – Bit Operation Statement]
15.6.5 Table Operation

This operation statement performs a number of operations on a specified table. As per figure 15.5 the table definition is defined as the number of local registers in the table beginning at the specified local register.

The available operations are:

1. Total
   This action sums the contents of the registers and stores the result in the target register.

2. Average
   This action averages the contents of the registers and stores the result in the target register.

3. Maximum
   This action searches the contents of the registers and stores the maximum value in the target register.

4. Minimum
   This action searches the contents of the registers and stores the minimum value in the target register.

5. Move To
   This action moves the contents of the registers in the table as a memory block, to a memory block beginning at the target register.
6. **Swap With**
   This action moves the contents of the registers in the table as a memory block, with a memory block beginning at the target register.

7. **Reset**
   This action resets the contents of each of the registers in the table to zero.

### 15.6.6 Function

**Root**
This function puts the square root of the contents of the first register in the second specified register.

**ToBCD**
This function converts the contents of the first register to Binary Coded Decimal and stores it in the second specified register.

**FromBCD**
This function converts the contents of the first register from Binary Coded Decimal and stores it in the second specified register.

### 15.6.7 Control Flow

1. **Pause**
   This command allows the programmer to pause the mathematic function for a specified number of seconds.

2. **Goto**
   This command allows the programmer to jump to a specified line number of the end of the function.

3. **Gosub**
   This command is similar to the **Goto** command however when an **End** command is reached the program flow returns to line immediately after line where the Gosub command was executed.

### 15.6.8 Set End

This action denotes the end of a mathematic function.
15.7. **Background Functions**

The CTIU10X/11X/20X terminals background function facility allows the terminal to continually run up to 8 maths functions automatically, without operator intervention. These functions can be programmed to run repeatedly after a specified time interval or be executed once on initialisation of the terminal.

To program a background function, choose **Background Functions** from **Edit** menu, in the **Mathedit Application Window**. Figure 15.6 shows the background function set-up window.

![Figure 15.6 – Background Function Set-up Window](image)

### 15.7.1 To Program a Background Function

1. Enable one of the 8 background functions by clicking in the tick box next to the number of the background function.
2. Click **Restart Function** if the function is to be executed only on initialisation of the terminal.
3. In the **Seconds** field specify the time interval between executions of the function.
4. In the **Call** field, specify the function to be called, this is the line number where the function begins.
15.8. Schedule Functions

Scheduled Functions have been provided as a means of initiating functions on a time and day basis. There are 16 schedules available each of which specifies a time of day and day of the week at which a Maths Function is to be called.

To configure the scheduled functions for the TIU terminal select Scheduled Functions from the Edit menu.

![Figure 15.7 - Schedule Functions Window]

### 15.8.1 To Set-Up a Schedule Function

1. Enable the schedule by clicking on the tick box corresponding to the schedule number.
2. In the Time enter the time of day at which the function is to be executed.
3. Click the day or days on which the function is to be executed.
4. In the Call field enter the mathematic function to be executed, this is the line number of the mathematic function.

15.9. Data Transfer Block

Local registers in the terminal can be mapped to registers in the automated equipment using the Data Transfer Block facility.
15.9.1 To Add a Block Transfer

1. From the Edit menu choose Data Transfer Block.

2. Click on the Add button to add a Map Register Statement. Figure 15.9 illustrates the how the registers are mapped.

3. Enter the Data Type Register and Location of the automated equipment registers.

4. Enter the block size or the number of registers to be mapped.

5. The registers maybe mapped in two directions, from the terminal to the automated equipment or from the automated equipment to the terminal. Choose which transfer direction.

6. The Period is the time interval between data transfers. In the Period field enter how often the data is to be transferred.

7. Finally enter the first local register where the data is to be transferred to or transferred from.

![Figure 15.8 – Data Transfer Block](image-url)
Figure 15.9 – Mapping PLC Registers and Local
16. SmartStack™

16.1. General
Control Techniques has now added the SmartStack™ modules to the CTIU20X range. The SmartStack system is a method of allowing I/O expansion on an HMI. As well as CTNet, a wide range of Digital and Analogue I/O modules is available.

16.2. Installing and Removing a SmartStack Module

The following section describes how to install and remove a SmartStack Module.

**Caution:** To function properly and avoid possible damage, do not install more than four Smart Stack™ Modules per CTIU20X.

a. Installing SmartStack Modules

1. Hook the tabs. Each SmartStack Module has two tabs that fit into slots located on the CTIU20X. (The slots on the CTIU20X are located on the back cover.)
2. Press the SmartStack Module into the “locked” position, making sure to align the SmartStack Module fasteners with the SmartStack receptacles on the CTIU20X.

b. Removing SmartStack Modules

1. Using a Flathead screwdriver, pry up the end of the SmartStack Module (opposite of tabs) and swing the module out.
2. Lift out the tabs of the module.

![Diagram of SmartStack Module installation](image-url)

**Figure 16.1 – Installing a SmartStack™ Module in an CTIU 200.**
16.3. Configuring SmartStack Module

At this time the range of compatible SmartStack modules for the TIU range is as follows:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HE800ADC110</td>
<td>4 channel Analog Inputs, Voltage (0-5vdc, +/−5vdc, 0-10vdc, +/−10vdc), 12 bit</td>
</tr>
<tr>
<td>HE800DIQ511</td>
<td>4 Channel 12/24 Vdc Digital Input Pos/Neg logic 4 Channel 12/24 Vdc Digital Output Neg logic</td>
</tr>
<tr>
<td>HE800DIQ512</td>
<td>4 Channel 12/24 Vdc Digital Input Pos/Neg logic 3 Channel Relay Output</td>
</tr>
<tr>
<td>HE800DIQ522</td>
<td>4 Channel 120 Vac Digital Input Pos logic 3 Channel Relay Output</td>
</tr>
<tr>
<td>HE800DIQ611</td>
<td>8 DC Inputs (12/24vdc, pos/neg logic), 8 DC Outputs (5/12/24vdc, 0.5A, neg logic)</td>
</tr>
<tr>
<td>HE800DIQ612</td>
<td>8 DC Inputs (12/24vdc, pos/neg logic), 6 Relay Outputs (250vac, 30vdc, 4.0A)</td>
</tr>
<tr>
<td>HE800DIQ622</td>
<td>8 AC Inputs (120 vac), 6 Relay Outputs (4.0Aper point)</td>
</tr>
</tbody>
</table>

Click on the SmartStack Configuration icon or choose **SmartStack I/O** from the **Configuration** menu.

From the Configure SmartStack I/O window, click on the pull down menu for the appropriate slot.

The available modules are listed, choose the module to be installed.

![Configure Smart Stack I/O](image-url)

*Figure 16.2 – SmartStack Configuration*
16.4. SmartStack I/O
The input and output of the smartstack is handled within the local registers of the terminal. The local registers and therefore the I/O of the smartstack is then analysed or manipulated within the Mathedit Application of the CTIU software. See chapter 15 for more information on the Mathedit Application.

16.5. Module Addressing

The base addressing for the slots are as follows:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Base Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>00001</td>
</tr>
<tr>
<td>2</td>
<td>10001</td>
</tr>
<tr>
<td>3</td>
<td>20001</td>
</tr>
<tr>
<td>4</td>
<td>30001</td>
</tr>
</tbody>
</table>

The input and output register names and addresses are as follows:

<table>
<thead>
<tr>
<th>I/O Type</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit Input</td>
<td>%Innnnn</td>
</tr>
<tr>
<td>Bit Output</td>
<td>%Qnnnnn</td>
</tr>
<tr>
<td>Word Input</td>
<td>%AInnnnn</td>
</tr>
<tr>
<td>Word Output</td>
<td>%AQnnnnn</td>
</tr>
</tbody>
</table>

- nnnnn = the base address of the module
- The base address begins at nnnnX and is incremented by 1 to the last channel on the module. ($X = 1$ or 0 depending on the bit base numbering set-up under Configure/Bit Base Numbering, default is 1)

All examples below assume Least Significant Bit for Internal References is set to 1.
E.g. the third bit of a Digital Input module in slot 3 would have the address of %I20003.
E.g. the fourth bit of a Digital Output module in slot 3 would have the address of %Q20004.
E.g. the third channel of an Analogue Input module in slot 4 would have the address of %AI30003.

Note: Digital Input modules can be read as words or bits by selecting the appropriate register type. Digital Output modules can be written to as words or bits by selecting the appropriate register type. The system will strip off any redundant bits within the word.

16.6. Displaying Data From SmartStack

Data from SmartStack modules can be embedded into a menu page in exactly the same way as other Automation Equipment devices. Embed the data type as normal and select the Location from the range of “Smart I/O” register types shown in the pull down register table. The normal function can then be applied to the register value, i.e. Range Checking, Scaling etc.

Note: The numeric default settings for Analogue modules should be set to 16 bit and signed.
Output data can be edited / scaled using the screen editor in the same way as a normal AE.
Data to / from SmartStack can also be scaled or manipulated via the Maths.

Note: The numeric default settings for Analogue modules should be set to 16 bit and signed.
Output data can be edited / scaled using the screen editor in the same way as a normal AE.
It is not possible to read and then modify Output types directly within a TIU system. If it is necessary to do this, it is better to use a System %R register within the Maths facility to manipulate and hold the “master value” then assign the actual value to a %AQ register. See Chapter 15 Mathematics on writing and calling maths functions. Again, it is good practise to write to an Output type at only 1 point in the configuration.

```
5 %R0005 = %R0005 + 2
6 IF %R0005 > 128 GOTO 10
7 IF %R0005 = 0 GOTO 10
8 %A00001 = %R0005
9 %A010001 = %R0005
10 %R0005 = 1
11 GOTO 8
```

**Figure 16.3 – Math Example Word**

### 16.7. Considerations for Shutting Down & Restarting a CTIU20X with I/O

During a “shutdown” for downloading, it is possible to leave SmartStack outputs on. It is therefore important to make sure that all outputs are in a safe condition before this operation is carried out. For example, this could be implemented using a dedicated Function Key labelled SHUTDOWN to call a Maths function that set any SmartStack outputs to a safe state for shutdown.

During a restart either from a “Power Up” or from after a download, SmartStack outputs may not always be in the mode required. This situation could be overcome by calling a Restart Maths function to correctly initialise the SmartStack output modules. Examples are shown below.

```
25 %A00001 = 7
26 %A010001 = 0
27 %A020001 = -8000
28 %A030002 = 8000
```

**Figure 16.4 – Math Example Set Outputs for Power**

**Figure 16.5 – Calling Math Function From Function**

**Figure 16.6 – Calling Math Function from Background**